This Documentation, which includes embedded help systems and electronically distributed materials, (hereinafter referred to as the “Documentation”) is for your informational purposes only and is subject to change or withdrawal by CA at any time.

This Documentation may not be copied, transferred, reproduced, disclosed, modified or duplicated, in whole or in part, without the prior written consent of CA. This Documentation is confidential and proprietary information of CA and may not be disclosed by you or used for any purpose other than as may be permitted in (i) a separate agreement between you and CA governing your use of the CA software to which the Documentation relates; or (ii) a separate confidentiality agreement between you and CA.

Notwithstanding the foregoing, if you are a licensed user of the software product(s) addressed in the Documentation, you may print or otherwise make available a reasonable number of copies of the Documentation for internal use by you and your employees in connection with that software, provided that all CA copyright notices and legends are affixed to each reproduced copy.

The right to print or otherwise make available copies of the Documentation is limited to the period during which the applicable license for such software remains in full force and effect. Should the license terminate for any reason, it is your responsibility to certify in writing to CA that all copies and partial copies of the Documentation have been returned to CA or destroyed.

TO THE EXTENT PERMITTED BY APPLICABLE LAW, CA PROVIDES THIS DOCUMENTATION “AS IS” WITHOUT WARRANTY OF ANY KIND, INCLUDING WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NONINFRINGEMENT. IN NO EVENT WILL CA BE LIABLE TO YOU OR ANY THIRD PARTY FOR ANY LOSS OR DAMAGE, DIRECT OR INDIRECT, FROM THE USE OF THIS DOCUMENTATION, INCLUDING WITHOUT LIMITATION, LOST PROFITS, LOST INVESTMENT, BUSINESS INTERRUPTION, GOODWILL, OR LOST DATA, EVEN IF CA IS EXPRESSLY ADVISED IN ADVANCE OF THE POSSIBILITY OF SUCH LOSS OR DAMAGE.

The use of any software product referenced in the Documentation is governed by the applicable license agreement and such license agreement is not modified in any way by the terms of this notice.

The manufacturer of this Documentation is CA.

Provided with “Restricted Rights.” Use, duplication or disclosure by the United States Government is subject to the restrictions set forth in FAR Sections 12.212, 52.227-14, and 52.227-19(c)(1) - (2) and DFARS Section 252.227-7014(b)(3), as applicable, or their successors.

Copyright © 2012 CA. All rights reserved. All trademarks, trade names, service marks, and logos referenced herein belong to their respective companies.
CA Technologies Product References

This document references the following CA Technologies products:

- CA 1® Tape Management (CA 1)
- CA ASTEX™ Performance (CA ASTEX)
- CA CREWS™ Catalog Recovery (CA CREWS)
- CA Datacom®/DB (CA Datacom/DB)
- CA Disk™ Backup and Restore (CA Disk)
- CA IDMS™/DB (CA IDMS/DB)
- CA MasterCat™ VSAM Catalog Management (CA MasterCat)
- CA PDSMAN® PDS Library Management (CA PDSMAN)
- CA Roscoe® Interactive Environment (CA Roscoe)
- CA Storage Resource Manager (CA SRM)
- CA SYSVIEW® Performance Management (CA SYSVIEW)
- CA Tape Encryption
- CA Encryption Key Manager
- CA TLMS® Tape Management (CA TLMS)
- CA Vantage™ Storage Resource Manager (CA Vantage SRM)
- CA Graphical Management Interface (CA GMI)
- CA Vtape™ Virtual Tape System (CA Vtape)
Contact CA Technologies

Contact CA Support

For your convenience, CA Technologies provides one site where you can access the information that you need for your Home Office, Small Business, and Enterprise CA Technologies products. At http://ca.com/support, you can access the following resources:

- Online and telephone contact information for technical assistance and customer services
- Information about user communities and forums
- Product and documentation downloads
- CA Support policies and guidelines
- Other helpful resources appropriate for your product

Providing Feedback About Product Documentation

If you have comments or questions about CA Technologies product documentation, you can send a message to techpubs@ca.com.

To provide feedback about CA Technologies product documentation, complete our short customer survey which is available on the CA Support website at http://ca.com/docs.
Contents

Chapter 1: Introducing CA GMI 7
About CA GMI ........................................................................................................................................... 7
The Object Tree ........................................................................................................................................... 9
Standard CA GMI Features ....................................................................................................................... 11
  Standard Object Views ........................................................................................................................... 12

Chapter 2: Setting Up CA GMI 61
CA GMI Components ............................................................................................................................... 61
Install and Configure CA GMI .................................................................................................................. 62
Start and Log In to the Windows Client .................................................................................................... 64
  Windows Client Menu Bar and Toolbar Options .................................................................................. 66
  The Windows Client View ...................................................................................................................... 66
Define a z/OS Host .................................................................................................................................. 68
  Host List Dialog Toolbar Options ......................................................................................................... 70
Connect and Log In to the z/OS Host ......................................................................................................... 70
Define the Data Collection Mode ............................................................................................................ 72
Closing the Windows Client ....................................................................................................................... 74

Chapter 3: z/OS Host Configuration 75
Software Requirements .............................................................................................................................. 75
How the Default Configuration Works ..................................................................................................... 76
Alter the Default Configuration ................................................................................................................ 77
Configure the CA GMI Interface .............................................................................................................. 78
Configure the CA SYSVIEW User Address Space .................................................................................. 80
F gmiaddr, SYSVIEW Command—Modify the Component Task ................................................................ 80
Distributed Configuration Parameters ...................................................................................................... 81

Chapter 4: Using CA SYSVIEW Objects 85
How Security Validation Works ................................................................................................................ 85
Use the GMI Windows Client GUI to Access CA SYSVIEW Objects .......................................................... 87
CA SYSVIEW Object Tree ......................................................................................................................... 89
  Administration Object Tree .................................................................................................................. 90
  z/OS Object Tree ............................................................................................................................... 93
  CICS Object Tree .............................................................................................................................. 98
  JES Object Tree .................................................................................................................................. 102
Chapter 1: Introducing CA GMI

**Note:** The following software versions were used to create the screen samples and examples in this guide:

- CA Vantage SRM Windows Client Release 12.5
- CA Vantage SRM Web Client Release 12.5
- CA Vantage SRM Release 12.5

This section contains the following topics:

- About CA GMI (see page 7)
- The Object Tree (see page 9)
- Standard CA GMI Features (see page 11)

About CA GMI

CA GMI is the graphical management interface product that allows you to view and manage mainframe activity from a PC. It consists of user-interface clients which interface with a z/OS server component to allow access to basic z/OS server functions.

The following user-interface clients are available:

**Windows Client**

This client provides full functionality. That is, you can manually perform view and analysis functions, filter and sort desired entries, zoom (drill-down) to related objects, and take actions upon selected entries. You can create customized colored reports in different formats, for example, tables and graphs in HTML, PDF, and XLS formats. These reports can be printed and exported to your PC directory, servers, intranet, and so on. The Windows Client has a Scheduler component that manages scheduled tasks defined in the Windows Client (for example, tasks scheduled using the View and Output Definitions, and Object Logging functions). You can create, manage, and view Summary Objects and Joined Objects. This client also provides designer wizards to create scripts to monitor and respond to any condition, exceptional or routine, in automatic ways. These automation services let you replace many manual processes of managing your system. It also has a JCL Management feature to manage JCL and includes the Host Config Client which you can use to set CA Vantage SRM system parameters.

**Note:** The Joined Objects feature requires a CA Vantage SRM base license and at least CA Vantage SRM Release 12.5 on the z/OS hosts. Automation services requires a CA Vantage SRM Automation Option license.
**Web Client**

As a browser interface, it can be used from any PC with internet access to the Web Client’s application server. The current version of the Web Client provides the user-driven functionality of view and analysis, filtering and sorting, zooming, and the ability to take actions on selected entries. You can create customized colored reports in different formats, for example, tables and graphs in HTML, PDF, and XLS formats. These reports can be printed and exported to your PC directory, servers, intranet, and so on. The Web Client has a Scheduler component that manages scheduled tasks defined in the Web Client (for example, you can schedule output reports). You can create, manage, and view Joined Objects, and you can view Summary Objects.

**Note:** The Joined Objects feature requires a CA Vantage SRM base license and at least CA Vantage SRM Release 12.5 installed on the z/OS hosts.

**3270-based interface (View 3270 Client)**

This client provides partial functionality. It is limited to the user-driven functionality of view and analysis, filtering and sorting, zooming, and the ability to take actions on selected entries.

**Note:** The View 3270 Client is considered a character-based user-interface, not a graphic-based user-interface, so it is not discussed in this guide. For View 3270 Client installation and configuration information, see the *CA Vantage SRM Configuration Guide*. For more information about using the View 3270 Client, see the chapter "Navigating the View 3270 Client" in the *CA Vantage SRM User Guide*.

**Note:** This guide mostly displays examples from the Windows Client, which are similar in many respects to the Web Client. For more information about Web Client features, see the *CA Vantage SRM Web Client Guide*.

CA GMI is included free of charge with many CA products. The CA GMI components only need to be installed once. However, you must configure the z/OS server component for each CA GMI enabled CA product you want to use CA GMI for, on each host where you want to use it. The following is the list of CA GMI enabled CA products:

- CA 1
- CA ASTEX
- CA CREWS
- CA Disk
- CA IDMS/DB
- CA Encryption Key Manager
- CA MasterCat
- CA PDSMAN
- CA SYSVIEW
The Object Tree

You access all user-interface functions from the main window of the user-interface. The Object Tree is a major feature on the main window of the user-interface.

The expandable and collapsible Object Tree lists all the source objects in a hierarchical tree structure. A folder icon represents a grouping of objects in the tree. When you expand a folder you will either view subfolders, the objects in the folder, or both. Different types of objects are represented by different icons and their title. A source object contains all the fields updated by the data collection services for that object. All fields or any subset of them can be included in user-defined views based on the source object.

In the Windows Client, the Object Tree is displayed in its own window. To display the Object Tree in the Windows Client, click the Object Tree icon in the Windows Client toolbar. The following is a sample of the Windows Client Object Tree window:
In the Web Client, the Object Tree is displayed in the GMI Tree navigation pane in the Web Client main window. The following is an example of the GMI Tree navigation pane in the Web Client main window:

You can access CA GMI enabled product objects using the user-interfaces, and the following basic CA Vantage SRM storage management objects:

- CA Vantage Internal Management, which includes the following objects and sub-folders:
  - All Summary Objects
  - JCL Model List
  - Internal Status Monitor
  - Log and Warm Start Status
Standard CA GMI Features

CA GMI user-interfaces provide a rich set of standard features for working with your products and related object data. These features include the following:

- Simultaneous connection to several z/OS hosts, with separate views for each host, or all hosts consolidated into a single view
- Table views of all data, customizable with the ease of point-and-click
- Graphical views of any numeric data, easily customized, with a wide range of two-dimensional and three-dimensional features
- Filtering and sorting on any field
- Summary Totals and Statistics (aggregate functions such as total, average, minimum, and maximum)
- Scaling (KB, MB, GB, and so on) and color coding features
- Drill-down feature to zoom to related object data
- Wizards for simple or complex summaries (Summary Objects)

**Note:** Currently, you can create and manage Summary Objects using only the Windows Client. You can view Summary Objects using both the Windows Client and the Web Client.

- Reporting features for customized and printed reports

To find out more about these objects in the Windows Client, right-click the object in the object tree and click the Help on Object option. To display the Object Help in the Web Client, open the object, click Help, and then Object *object_name* Help.
Standard CA GMI Features

- Multiple output formats, including:
  - Web page (HTML)
  - Email
  - PDF
  - Excel
  - Microsoft Access Database (MDB)
    **Note:** This output format is only available from the Windows Client.
  - Comma Separated Values (CSV)
    **Note:** This output format is only available from the Web Client.

- Schedulers for producing and sending report output on a regular basis
- JCL management (edit, model, drag and drop, substitute, submit, and schedule)
  **Note:** Currently, JCL management is only available in the Windows Client.

The following sections provide examples of some of the standard features of the Windows Client:

- **Standard Object Views** (see page 12)
- **Standard View Options** (see page 30)
- **Other Standard Features** (see page 49)

Standard Object Views

The standard object views in the Windows Client are the Table View, Graph View, and List View. The standard object view in the Web Client is the table view and you can create charts (graphs) of object information (data).

The following sections describe the Table View of both clients and the Graph View of the Windows Client.

Table Views

In both the Windows Client and the Web Client, the default view of objects is the Table View. The Table View displays object information (data) in configurable tables. You can change display characteristics (such as the width and number of table columns, the number of rows displayed, and so on) and characteristics that apply to specific objects, such as sort and filter criteria. The display and object-specific characteristics determine the appearance of the table. When you save your user-defined views of objects, you automatically save the display and object characteristics with it.
The following is a sample of an object table displayed by the Web Client:

![Object Table](image1)

The following is a sample of a Table View of an object displayed by the Windows Client:

![Table View](image2)

In the Windows Client, you can change the view type, for example from the Table View to the Graph View, or List View by clicking the **Switch to** icon in the bottom left corner of the object window, as shown in the sample Table View. In the Web Client, if you have created a chart (graphic) view of object data then the chart is displayed above the table.
Table View Dialog Toolbar Options

The Web Client Customize Menu provides access to the Customize View Wizard and the Customize Report Wizard. The Customize View Wizard provides object view customize options such as: filter, sort, charting (object graphs), hide or display columns, rename columns, and so on. The Customize Report Wizard allows you to create and manage output reports and output report schedules.

The Windows Client Table View dialog toolbar provides the following options:

The Windows Client Table View dialog toolbar icons can vary depending on the object being displayed. The following are just a couple of the additional icons that may appear depending on the object being displayed:

View Info Area Icon ( )

Displays an information area (Info Area) window that contains information unique to the object, or other information related to the entire object.

Note: To see an explanation of the information displayed in the information area window, open the Help About Object online help system from the object’s toolbar.

Input List Icon ( )

Allows you to specify the input that creates the object. The type of input can vary from object to object. In some cases, such as when working with CA Disk archive and backup data, the Input List provides the names of one or more data sets from which the object data is extracted; that is, the CA Disk FILES Data Sets. In the case of the BCS Data Set Entries object (which lists catalog entries), the Input List is a data set name or data set name pattern to be found in the system catalogs. For other objects, the Input List is an input command to the specific product that produces the object.

In most cases, each Input List can be configured to provide system defaults. The Input List dialog allows you to override the default values. Click the Help button in the Input List dialog to find out how to use the dialog.
When the Input List consists of data set names, and GDGs are appropriate, either relative or absolute names may be entered. You may also specify System variables and System Symbols within the Input List, and their active values will be substituted.

**Note:** Because an Input List is not executed in any specific object context, you cannot use Object Related variables for substitution.

**Note:** For more information about the Table View dialog toolbar options, see the CA Vantage SRM Windows Client Guide and the Help About Window online help system.

### Additional Table View Options

In addition to the Web Client menu and toolbar options, you can click the down arrow next to a column heading and sort the object table by that column in ascending or descending order. You can also click the down arrow next to a column heading and specify which columns you want to display or hide. The following is an example of the Web Client's Object Column Headings Options menu, where the down-arrow next to the % Alloc column heading is selected:

![Web Client Object Column Headings Options menu](image)

**Note:** The Web Client Customize View Wizard also provides sort and column display or hide options.

In addition to the Windows Client Table View menu and toolbar options you can also perform some quick appearance changes to the Table View as follows:

- Quick Find in Column
- Quick Sort on Columns
■ Quick Color Code a Column
■ Move the Freeze Column Line
■ Return a Table View to Factory Settings

How to perform these changes is explained in the following procedures.

**Note:** The following Windows Client options and more options for customizing a view are available in the View and Output Definition feature. For more information, see the section Customized Reports (see page 42).

**To Quick Find in Column**

Instead of scrolling down to a row you can quickly find a particular item. To do this you can use the Quick Find in Column option by following these steps:

1. Right click the column heading which contains the item you want to find.
   The Column Options Menu is displayed as shown in the following sample:

   ![Column Options Menu](image)

2. Click the Find option in the Column Options Menu.
   The Find dialog is displayed.

3. In the Find What field type in the item you want to find. You can type in part of the item, for example if you wanted to find ABC123 then you could type in ABC, ABC1, and so on.

4. Click Find Next.
   The Table View of the object is updated and the first item containing your find criteria is displayed. If the criterion is not found in the column then you will receive a message advising it is not found.
To Quick Sort on Columns

You can perform quick sorts in the Table View by clicking a column heading title cell and the table will sort by that column in descending order. Click the column heading title cell again and the table will sort by that column in ascending order.

You can also right click a column heading and the Column Options Menu is displayed where you can select the Sort Ascending or Sort Descending options. The following is a sample of the Column Options Menu:

<table>
<thead>
<tr>
<th>Column Color Coding</th>
<th>Find</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>Z</td>
</tr>
<tr>
<td>Sort Ascending</td>
<td>Sort Descending</td>
</tr>
</tbody>
</table>

Note: After you have created a Table View column sort in this manner you may want to remove it; to remove a Table View column sort, click the Sort icon and use the Exclude a Field option or the Exclude all Fields option. For more information, see the section Sort Option (see page 32).

To Quick Color Code a Column

You can highlight certain values in columns by color coding them when specific criteria is met. You have two options for color coding, you can use the Quick Color Code a Column option or you can use the View and Output Destination – Fields option (the View and Output Destination – Fields option, is described in the section Color Code Option (see page 37)).

To use the Quick Color Code a Column option, perform the following steps:

1. Right click the column heading of the column you want to color code.

   The Column Options Menu is displayed as shown in the following sample:

<table>
<thead>
<tr>
<th>Column Color Coding</th>
<th>Find</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>Z</td>
</tr>
<tr>
<td>Sort Ascending</td>
<td>Sort Descending</td>
</tr>
</tbody>
</table>
2. Click the Column Color Coding option in the Column Options Menu.

The Column Color Code dialog is displayed. The following is a sample of the Column Color Code dialog displayed for the Volumes column in the Storage Group Volumes object:

![Color Coding for Volume dialog](image)

3. Click in the first empty Condition cell.

A down arrow appears on the right side of the cell.
4. Click the down arrow on the right side of the cell.

The Condition options are displayed as shown in the following sample:

![Color Coding for Volume](image)

5. Select the condition you want.

The condition selected is displayed in the cell.

6. Click in the Value cell of the same row you selected the condition. Type in the value that you want the condition applied to.

The value is displayed in the cell.
7. Click the Color cell of the same row you selected the condition and typed in a value.

The Color dialog is displayed as shown in the following sample:

![Color dialog]

8. In the Color dialog select the color you want to appear as the background for the items that meet your criteria and click OK.

The Column Color Code dialog is displayed showing the condition, value and color you have specified.
The following is an example of the Column Color Code dialog where the condition is ‘=’, the value is ‘ACFQA1’ and the color is blue for the Volumes column in the Storage Group Volumes object:

![Column Color Code Dialog]

9. Click OK.

The Table View of the object is displayed with your color code settings.

10. In the Table View menu select File and then click Save, to save your settings.

If you save the Table View with the column color code setting then every time you open the object the color codes are applied. To remove the column color coding; display the object, right click the column, select No Colors, and then click OK in the Column Color Code dialog.

Observe the following:

- You can apply the color coding to the cells in the column selected or you can apply the color coding to the whole row by selecting the Apply to Row option.
- You can apply predefined color code values by selecting the Use predefined colors button ( ).
You can save the column color codes you have created so that you can use them later by selecting the Store these colors as predefined button.

You can have multiple conditions, values, and colors to the same column. However, the Windows Client checks the conditions sequentially until the first match occurs and it uses ANSI character sort order for the comparison (for example: 0-9, A-Z, and a-z). If one value meets two or more conditions then the first condition is applied.

For example: if you color code two conditions in the dialog such that ‘= AAAA1 Blue’ is listed first, and then ‘> AAAA0 Red’ is listed second in the dialog then the Windows Client will apply the ‘= AAAA1 Blue’ condition to all AAAA1 items, then it will apply the second condition, ‘> AAAA0 Red’, to any items that meets the second condition but where the first condition has not been applied. If the conditions are reversed in the dialog so that ‘> AAAA0 Red’ is first and ‘= AAAA1 Blue’ is listed second in the dialog, then the second condition, ‘=AAAA1 Blue’, would be ignored because items with values AAAA1 have already met the first condition and the red color coding is already applied to them.

There are no "and" or "or" condition statements available for color coding multiple conditions, values, and colors to the same column. There are simply the 'less than', 'less than or equal to', 'equal to', 'greater than', 'greater than or equal to', 'less than or greater than' and 'Range' (for numerical fields only) conditions available for comparison to the values you specify.

To Move the Freeze Column Line

You can freeze columns so that when you scroll to the right in a Table View, certain columns stay in the view. The black vertical line separating columns is the Freeze Column Line. The following illustration shows the factory default Freeze Column Line for the Storage Group Volumes object:
To include the Type and Volumes columns as Freeze Columns perform the following steps:

**Note:** You can similarly include as many columns as you want as Freeze columns in any Table View of an object.

1. Click on the vertical line between the SG Name and the Type columns and drag-and-drop it to the vertical line between the Volume and the CUA1 columns.

   **Note:** You must click and drag the line anywhere below the column heading portion of the line, that is, it will not work if you click and drag the section of the line between the column headings.

   The Freeze Column Line is now displayed between the Volume and the CUA1 columns as shown in the following sample:

   ![Freeze Column Line moved](image)

   When you now scroll to the right in the Storage Group Volumes object the SG Name, Type and Volume columns will always be displayed in the left columns of the view.

   2. In the object view menu click File and then Save, to save your settings.

      If you save your settings then every time you open the object the Freeze Columns line will be where you saved it. Alternatively you can just close the Table View without saving your Freeze Column Line change and the next time you open the Table View for the object the Freeze Column Line will be where it was with the factory setting.
To Return a Table View to Factory Settings

Before you return an object view to factory settings note the following:

- By following this procedure you will erase all your settings in the view of the object, for example the Sort settings, Column Color Coding settings, Freeze Columns settings, Filter settings and so on.

- If you only want to remove a particular setting but not all your customized settings then open the tool option for the setting you want to remove and remove it. The following are a few examples of how to remove particular settings:
  - To remove column color code settings, open the Color Coding dialog for the column colors you want to remove and select No Colors.
  - To remove a filter, open the Filter dialog and click the Clear icon ( ) then Save. For more information, see the section Filter Option.
  - To remove your Freeze Columns settings, move the Freeze Columns line to the dividing line between the first and second column.
  - To remove column sorts, click the Sort icon ( ) and use the Exclude a Field option or the Exclude all Fields option. For more information, see the section Sort Option.
To return an object view to factory settings, perform the following steps:

1. Right click the object in the Object Tree.
   
The Object Options Menu is displayed. The following shows a sample of the Object Options Menu:

2. Click Return to Default Settings.
   
   A confirmation dialog is displayed.
3. Click Yes.

All the changes to the object that you have previously saved will now be replaced with factory default settings. You will see this change the next time you open the object.

Graph Views

The Graph View feature displays a selected set of object data in a graph.

**Note:** For Web Client users; the Customize View Wizard in the Web Client provides Charting options. These options allow you to create charts (graphs) of object data. For more information, see the *CA Vantage SRM Web Client Guide*.

The Windows Client offers a large variation of graph types to present your data in a variety of formats. Some of the available graph types are:

- Line
- Point
- Area-curve
- Bar
- Pie
- Doughnut
- Pyramid
- Cube

You can specify the graph type and its format to obtain the kind of display you prefer. You can preview the general look of a graph while defining its various features.

**Note:** To immediately view certain changes, you must click the Refresh icon ( ).
The following is a sample of the Windows Client Graph View of the Storage Groups object:

**Graph View Dialog Toolbar Options**

The Windows Client Graph View dialog toolbar provides the following options for working with graphs:

- **X-axis Source**
- **Y-axis Source**
- **Copy to Clipboard**
- **Print Preview**
- **Graph Gallery**
- **Horizontal Grid**
- **Values Legend**
- **Fonts**
- **Zoom**
- **Print**
- **Vertical Grid**
- **Legend Box**
- **2D and 3D Views**

**Note:** For more information about the Graph View dialog toolbar options, see the CA Vantage SRM Windows Client Guide and the Help About Window online help system.

**Additional Graph View Options**

In addition to the Windows Client Graph View menu and toolbar options you can also perform some quick appearance changes to the Graph View as follows:

- Increase or Decrease Number of Items Displayed
- Quick Gallery Option (to change graph type)
- Quick Color Option (to change graph color)
Quick Multiple Colors Option

How to perform these changes is explained in the following procedures.

Note: The following options and more options for customizing a view are available in the Windows Client View and Output Definition option. For more information, see the section Customized Reports (see page 42).

Increase or Decrease Number of Items Displayed

When you switch the object view from Table View to Graph View by clicking the Graph icon in the bottom left corner of the view, the Graph View will display the same amount of items that were displayed in the Table View. For example, if the Table View displayed 8 rows of X records found then the Graph View will display only those 8 items. If you want the Graph View to display more items then switch back to the Table View and expand the window to display more rows. Then when you switch back to the Graph View it will display the same amount of items. For example, if the Table View displayed 8 rows and you expand the Table View to display 10 rows then when you switch to the Graph View it will display 10 items.

You can also use the Sort Option and the Filter Option in order to specify the order of the items and reduce the amount of items you want to display in the graph, prior to switching to the Graph View.

Note: When you print a Graph View, all records (not only the ones displayed in Graph View on your screen) will be included in the printout unless you specify a range in the print option.

Quick Gallery Option to Change Graph Type

When a Graph View is displayed you can use the Quick Gallery option to change the graph type. (This option is the same as the Gallery icon option found on the Graph View toolbar, this is another method for initializing the same option.)

To use the Quick Graph Type Change option

1. Right click in the graph of the Graph View.

   The Graph Options Menu is displayed as shown in the following sample:

   ![Gallery Options Menu]

2. Click the Gallery option and a list of graph types is displayed as shown in the following sample:

   ![List of Graph Types]
3. Click on the graph type you want to change to.

The Graph View is updated and the new graph type selected is displayed.

**Quick Color Option to Change Graph Colors**

When you switch to the Graph View, all the bars will have the same color. To apply different colors to the bars you must first use the Quick Multiple Colors Option. Then you can right click a particular bar and specify a color for that bar. The following procedure assumes you have the object displayed in the Graph View and all the bars have the same color.

**To use the Quick Graph Color option to specify a color**

1. Right click on a particular item (for example a bar) in the graph.

   The Graph Options Menu is displayed as shown in the following sample:

   ![Graph Options Menu]

   - Gallery
   - Color
   - Multiple Colors

2. Select the Multiple Colors option.

   The Graph View is displayed and the graph items are displayed by a different color.

3. Right click on the item (for example a bar) in the graph you want to specify a color for.

   The Graph Options Menu is displayed.

4. Click the Color option.

   A color chart is displayed as shown in the following sample:

   ![Color Chart]

5. Click on the color you want the item changed to.

   The item in the Graph View is displayed with the color selected.
Quick Multiple Colors Option

When you switch to the Graph View, all the bars will have the same color. To apply different colors to the bars you can use the Quick Multiple Colors Option. Then you can right click a particular bar and specify a color for that bar as described in the section Quick Color Option. The following procedure assumes you have the object displayed in the Graph View and all the bars have the same color.

To use the Multiple Colors Option

1. Right click on any item (for example a bar) in the graph.
   
   The Graph Options Menu is displayed as shown in the following sample:

   ![Graph Options Menu]

2. Click the Multiple Colors option.
   
   The Graph View is updated with each item displayed by a different color.

   **Note:** To return the Graph View so that all items use the same color, right click an item (for example a bar) in the graph and select the Multiple Colors option.

Standard View Options

In both the Windows Client and the Web Client, each standard view of object data provides options you can use to manipulate object information so it is presented the way you like. Some of the more common Windows Client options are described in the following sections.

**Note:** For more information about these options in the Web Client, see the CA Vantage SRM Web Client Guide.

Filter Option

The Filter feature narrows the amount of object information (the number of rows) displayed in the table. The Windows Client lists the object fields in the Filter dialog in alphabetical order by field name. The Filter dialog guides you in the process of defining the filter expression by enabling and disabling the appropriate fields and controls at every step.

**Note:** For Web Client users; the Customize View Wizard in the Web Client provides a similar filtering feature. For more information, see the CA Vantage SRM Web Client Guide.
Example: Create a Filter

The following Windows Client example shows the filter criteria that would produce a user defined view showing only the CA Vantage SRM messages issued in the last 3 days. In the example a relative date of TODAY-3 is used instead of an absolute date. A relative date allows for reuse of the filter without you having to calculate and update the date. However you can use absolute dates (specific dates).

Filter Dialog Toolbar Options

The Windows Client Filter dialog toolbar provides the following options:

How Filters Work

A filter can be built from the fields of the object by combining them into Boolean expressions. You can also use expressions that contain patterns with wildcard characters.

You can refine your filter by using the AND/OR logical operators to combine several expressions. Use parentheses to group sub-expressions.
You can enter a filter expression directly into the text box at the bottom of the Define Filter dialog or use the typing aids in the dialog. It is possible to edit any expression in the text box.

Observe the following:

- For more information about how filters work click the Help icon in the Filter dialog.
- To immediately view the effect of your filter you must click the Apply and Refresh Data icon ( ).

**Sort Option**

The Sort feature sorts the table by the values in the columns of the table. Every object attribute (or field for z/OS) in a table can serve as a sort key. You can use the Windows Client Sort Dialog to sort object data in both the Table View and the Graph View.

**Note:** The Customize View Wizard in the Web Client provides a similar sort feature. For more information, see the CA Vantage SRM Web Client Guide.

The following is a sample of the Windows Client Sort dialog for the POOLS object. It points out how to include and exclude fields the object view is sorted by.

1. Double-click the Sort Order icon ( ) in the Sort Order pane of the Sort dialog.
   - The Ascending Sort Order icon ( ) appears.
2. Double-click the Sort Order icon again in the Sort Order pane of the Sort dialog.
   - The Descending Sort Order icon ( ) appears.

**Note:** To immediately view the effect of your sort you must click the Apply and Refresh Data icon ( ).

You can sort object data by columns directly in the Table View.
To sort the Table View by columns in the Windows Client

1. Click the column title you want the object data to be sorted by.
   The first time the column title is clicked the table is updated and sorted in ascending order by object data in that column.

2. Click the column title again to change the sort to descending order.
   The table is updated and sorted in descending order by object data in that column.

After you have created a Table View column sort in this manner you may want to remove it; to remove a Table View column sort, click the Sort icon (2) and use the Exclude a Field option or the Exclude all the Fields option.

Sort Dialog Toolbar Options

The Windows Client Sort dialog toolbar provides the following options:

- [Apply and Exit]
- [Apply and Open Filter]
- [Apply and Refresh Data]
- [Help]

Summary Totals and Statistics

The Windows Client Totals and Statistics Summary options in the View menu let you request the total of every numeric field, or combine the totals with the average, minimum, and maximum values.

**Note:** The Statistics option in the View menu of the Web Client provides a statistics and totals view of the object. For more information, see the CA Vantage SRM Web Client Guide.
Example: Access Summary Totals and Statistics options

The following example shows where to access the Summary Totals and Statistics options from the Windows Client View drop-down menu option in the Table View.
Totals Option

The Totals option provides the sum of all numeric fields, as shown in the following sample Windows Client Totals dialog.

![Show Totals / Totals](image1)

Statistics Option

The Statistics option provides totals plus the average, minimum, and maximum values for all numeric fields, as shown in the following sample Windows Client Statistics dialog.

![Show Statistics / Statistics](image2)
Scale Option

The Scale option list lets you select the scale base units for displaying numerical data. The difference between requesting K, M, G, and so on, as opposed to KB, MB, GB and so on is that those with the appended B mean multiples of 1024, while those without the B mean multiples of 1000. For example:

- nnK = nn(1000), nnM = nn(1000)(1000), and so on.
- nnKB = nn(1024), nnMB = nn(1024)(1024), and so on.

Note: The Customize View Wizard in the Web Client provides a similar field scaling feature. For more information, see the CA Vantage SRM Web Client Guide.

To scale a column of numeric data in the Windows Client

1. Click the Definitions icon on the Windows Client toolbar of the object view. The View and Output Definition dialog appears.

2. Click the Fields option in the left navigation pane of the View and Output Definition dialog. The Fields dialog appears.

3. Click the cell in the Scale column of the Field row for which you want to establish the scale for.

A scale options list appears as show in the following sample:
4. Select the scale you want to use.
   The scale selected appears in the cell in the Scale column of the Field.

5. Click OK.
   The View and Output Definition dialog closes and the object view is updated with the scales selected. The column heading displays the scale after the heading title, for example if you selected a scale of GB for Free Bytes the column heading title will indicate the scale is GB and would look like the following sample in your object view:

   Free Bytes (GB)

**Color Code Option**

The Color Code option lets you set conditions for color coding values in object Table Views.

**Note:** The Customize View Wizard in the Web Client provides a row and field coloring feature. For more information, see the *CA Vantage SRM Web Client Guide*.

**To color code values in object views in the Windows Client**

1. Click the Definitions icon ( ) from the toolbar of the object Table View.
   The View and Output Definition dialog appears.

2. Click the Fields option in the left navigation pane of the View and Output Definition dialog.
   The Fields dialog appears.
3. Click in the Color cell for a field you want to assign a background color.

   The Color Coding dialog appears. The following Color Coding dialog sample shows how you can select a condition, enter a condition value, and then select a background color for the item that meets the condition.

   ![Color Coding dialog sample](image)


   The condition, value, and color code you selected are displayed in the Color Code dialog.
5. Click OK in the Color Code dialog.

The Color Code dialog closes and the Graph icon (▏) appears in the Color cell in the Fields dialog, as shown in the following sample.

6. Click OK.

The View and Output Definition dialog closes. The object Table View appears with backgrounds of values that meet your conditions color coded.

**Open Zoom Option (DrillDown Feature)**

The Windows Client Open Zoom feature provides you with a list of objects that have related information. You can select an object from the Zoom list dialog to view the related information.

**Note:** The Web Client provides a Zoom feature on the Object toolbar. For more information, see the *CA Vantage SRM Web Client Guide*.

**To zoom to related objects in the Windows Client**

1. Select a row in the object Table View.

   The selected row is highlighted.

2. Click the Open Zoom icon (🔍).

   The Zoom list dialog appears, listing related objects.
3. Click an object in the Zoom list.
   Object information in the object selected for that item appears.

The following sample illustrates a zoom from a particular Volume in the Volumes object to the same Volume in the Data Set Name Blocks (DSNBs) object.

New Summary Objects Option

The Windows Client Summary Designer helps you create new summary objects from any source object. You select the method for defining the summary groups and select the fields to include in the summary object. The summary object includes summary groups from a source object table, and then provides statistics about all the object rows that fall into each summary group. The statistics include counts, maximum values, minimum values, average values, and totals. These statistics are provided for each group of records and for all the records.

You can start the Windows Client Summary Designer two ways, from the object pop-up menu or from the Object view Menu Bar.

Note: Currently, you cannot create or manage Summary Objects using the Web Client. You can view Summary Objects using the Web Client.

To start the Windows Client Summary Designer from the object pop-up menu
1. Right-click on the object in the Object Tree view.
   The Object pop-up menu appears.
2. Select New Summary Object in the Object pop-up menu.
   The Summary Designer appears.

To start the Summary Designer from the object view Menu Bar
1. Click the object in the Object Tree view.
   The object view appears.
2. Select View, then New Summary Object from the object view Menu Bar.
   The Summary Designer appears.

The following is a sample of the Summary Designer.

Note: For more information about how to use the Summary Designer to create a new Summary Object click the Help icon in the Summary Designer dialog, or see the chapter "Working with Generalized Summary Objects" in the CA Vantage SRM User Guide.
Customized Reports

You can customize reports with the appearance and information you want by using the Windows Client View and Output Definition feature.

Note: The Customize Reports Wizard in the Web Client provides an output report feature you can use to create and manage user-view object data output reports and schedules for output reports. For more information, see the CA Vantage SRM Web Client Guide.

The Windows Client View and Output Definition feature allows you to define:

- The z/OS hosts from which data is to be retrieved.
- The fields (columns) to be included in the report.
- The order of the fields (columns) displayed in the report.
- The sort, color, and scale of the data in the report.
- The layout design, contents, and record range of the report. This includes the grouping of the fields (columns) displayed in the report (using the Grouping facility in this feature).
- The report format (print, web publishing, email, PDF, HTML, XML, TXT, Excel, FTP Server, and so on).
- The destination of the report (the printer, the directory, web server, email address, FTP server ID, and so on).

To start the View and Output Definition feature in the Windows Client

1. Click the object in the Object Tree view.
   The object view appears.

2. Click the Definitions icon ( ) from the toolbar of the object view.
   The View and Output Definition dialog appears.

Example: Define fields to be displayed in a Storage Groups report

You can create a report based on the Storage Groups object that contains information on the SG Name, Type, % Allo, Vol Cnt, Capacity Bytes, Allocated Bytes and Free Bytes. You can then sort the report by descending % Allo.
The following example shows how you would define this report in the Windows Client View and Output Definition>View>Fields dialog.

![View and Output Definition of Storage Groups (POOLS)](image)

**Note:** For more information about the View and Output Definition dialog, click the Help icon in the View and Output Definition dialog.

**Multiple Output Formats**

You can use the Windows Client Output Report feature to define output formats, schedules, and destinations of your object view as it is currently displayed. When you select Destinations in the Output Report feature, you can indicate the format of the report and where you want a report to be published.

**Note:** The Customize Reports Wizard in the Web Client provides a output report feature where you can define output formats, schedules, and destinations of object user-view data. For more information, see the *CA Vantage SRM Web Client Guide*.

When using this feature in the Windows Client, the output includes all the information from your object view as it appears in your object view at the time you generate the report. Before you generate the report, you can use other object view options (such as filter, sort, color code, and so on) to design how the information appears in your object view and subsequently how the report appears. The number of records in the report depends on the Record Range settings. You also have the option of using the View and Output Definition feature to customize reports with the appearance and information you want.
To start the Output Report feature in the Windows Client

1. Click the object in the Object Tree view.
   The object view appears.

2. Select File, then Output Report from the object view menu.
   The Output Report dialog appears.

The following is a sample of the Windows Client Destinations dialog of the Output Report feature for the Storage Group object.

Each output destination gives you additional options as shown in the following example procedure for creating a Formatted File.

To produce a Formatted File using the Output Report feature

1. Click the box next to the File (PDF, HTML, XML, TXT) option in the Destinations dialog.
   A check mark appears in the box next to the File (PDF, HTML, XML, TXT) option and the Define file location link is highlighted.
2. Click the Define file location link.
   The Output Action>Destinations>File (Formatted Report Destinations) dialog appears with PDF (Adobe Acrobat) format selected as shown in the following sample.

   ![Output Report dialog](image)

3. Click the box next to the formats of the report you want to create and you can click the box next to PDF (Adobe Acrobat) option if you do not want to create a PDF file.
   The File: field is populated with a default location dependant on the formats selected.

4. Click the Browse button next to the File: field if you want to change where the report is to be filed.
   The File: field is populated with the new file location.

5. Click Perform.
   The Output Action>Destinations>File (Formatted Report Destinations) dialog closes, and the file is created and filed in the location indicated.

   **Note:** For more information about the Output Report dialogs, click the Help icon in the Output Reports dialog.
Print Report Option

You can quickly print an object view using the Windows Client Print Report icon (\(\text{Print Report}\)) from the toolbar of the object view.

**Note:** The Customize Reports Wizard in the Web Client provides a output report feature with output report options. You can then print the output report as you would any report. For more information, see the *CA Vantage SRM Web Client Guide*.

When using this Windows Client feature, the output includes all the information from your object view as it appears in your object view at the time you generate the report. Before you generate the report, you can use other object view options (such as filter, sort, color code, and so on) to design how the information appears in your object view and subsequently how the report appears. The number of records in the report depends on the Record Range settings. You also have the option of using the View and Output Definition feature to customize reports with the appearance and information you want.

To quickly print an object view using the Print Report icon in the Windows Client

1. Click the object in the Object Tree view. The object view appears.

2. Click the Print Report icon (\(\text{Print Report}\)) from the toolbar of the object view. The Output Action>Record Range dialog appears as shown in the following sample.

![Output Action>Record Range dialog](image)

3. Indicate how many rows of information you want printed. The number of rows you want included is indicated.

4. If you have defined a default printer in your Windows operating system and you want the print file sent to that printer click the Perform button. The Output Action>Record Range dialog closes and the print file is sent to your default printer. You do not need to perform any more of the following steps.
5. If you want to indicate the printer you want the report sent to click the Next button. The Output Action>Destinations dialog appears.

6. Click the Define the printer link
   
The Output Action>Destinations>Printer dialog is displayed as shown in the following sample:

![](image)

7. Click the down arrow at the end of the Printer field and select the printer you want the report sent to.
   
   **Note:** The Printer drop-down list includes all printers you have defined in your Windows operating system printer setup.

   The printer name selected appears.

   You can also use the Output Action>Destinations>Printer dialog to indicate number of copies, page orientation, and paper size.

8. Click Perform.

   The Output Action>Destinations>Printer dialog closes and the print file is sent to the printer.

   **Note:** For more information about the Output Report dialogs, click the Help icon in the Output Reports dialog.
Mail Report Option

You can email an object view report in PDF, HTML or Excel format using the Windows Client Mail Report icon (менно) from the toolbar of the object view.

**Note:** The Customize Reports Wizard in the Web Client provides an email output report option. For more information, see the *CA Vantage SRM Web Client Guide*.

When using this Windows Client feature, the output includes all the information from your object view as it appears in your object view at the time you generate the report. Before you generate the report, you can use other object view options (such as filter, sort, color code, and so on) to design how the information appears in your object view and subsequently how the report appears. The number of records in the report depends on the Record Range settings. You also have the option of using the View and Output Definition feature to customize reports with the appearance and information you want.

**To quickly mail an object view using the Mail option in the Windows Client**

1. Click the object in the Object Tree view.
   - The object view appears.
2. Click the Mail Report icon (менно) from the toolbar of the object view.
   - The Output Action>Record Range dialog appears.
3. Indicate how many rows of information you want included in the attachment report.
4. Click Next.
   - The Output Action>Destinations>e-Mail dialog appears with the box next to e-Mail checked and the Define mail addressee link highlighted.
5. Click Next.

The Output Action > Destinations>e-Mail dialog appears as shown in the following sample:

![Mail Report of Storage Groups](image)

**Note:** If you have defined a Mail to Address in the Global Options feature then that defined email address will be displayed in the Output Action> Destinations>e-Mail dialog.

6. Provide the email address, subject, body text to be included in the email, and file format of the attachment object view report, then click Perform.

The Output Action> Destinations>e-Mail dialog closes. An email is created and sent with the object view report attached.

**Note:** For more information about the Output Report dialogs, click the Help icon in the Output Reports dialog.

**Other Standard Features**

In addition to object views and related view options there are many additional standard features provided with both the Windows Client and the Web Client. These additional features can be found on the main window Menu Bar or Toolbar.

**Windows Client**

Windows Client additional features are explained in more detail in the *CA Vantage SRM Windows Client Guide* and the Windows Client *Help About Window* online help system.
Web Client

The Web Client also provides a Scheduler feature. End-users can create output report schedules using the Customize Reports wizard. Schedules and scheduled items can be managed using the Schedule Status feature found in the Tools menu. The Web Client Scheduler currently does not provide a JCL Management feature. The Web Client Scheduler feature is explained in more detail in the CA Vantage SRM Web Client Guide and the Web Client Navigation online help system.

The following sections give a short explanation to the Windows Client Scheduler and JCL Management features.

Scheduler

Both the Windows Client and the Web Client have Schedulers. The Schedulers provide a consistent set of scheduling services for all output activities within the user-interfaces. You can schedule events by month, week, day, hour, and minute.

For example, suppose you wanted to be kept up to date on the scratch status of volumes by displaying a daily report on your web site. To do this, you could schedule a report based on the Volumes object to run every morning at 9:00 AM and set the Destination of the report to Web Publishing in the Windows Client, or Publish to Web in the Web Client. With this setup, the user-interface automatically runs a report on current volume activity every morning and publish the web report on your web server.

Note: For more information about Web Publishing using the Windows Client, see the CA Vantage SRM Windows Client Guide. For more information about publishing reports to a web server using the Web Client, see the CA Vantage SRM Web Client Guide.

Both the Windows Client and the Web Client have Start Scheduler and Stop Scheduler options found under their Tools options. And the Windows Client has the Schedule List option and the Web Client has a Schedule Status option found under their Tools options which you can use to manage the different user-interface's scheduled items.

The Windows Client also has the Start Scheduler icon and the Schedule List icon in the Windows Client main menu Toolbar.

The following is an example of the Web Client Scheduler Status Window displayed when you select the Schedule Status option in the Tools menu:
The following is a sample of the Windows Client Schedule List window that is displayed when you select the Schedule List option:

### Schedule List Dialog Toolbar Options

The Web Client Scheduler Status Window provides the following options:

**Run**
- Runs the selected scheduled activities immediately.

**Edit**
- Modifies a Schedule.

**Enable/Disable**
- Enables or disables the selected schedules.

**Export to Excel**
- Exports the information displayed in the Activity List table.

**Refresh**
- Refreshes the information displayed in the Activity List table with the latest data from the web application database.

**Note:** For more information about the Web Client Scheduler Status Window, see the [CA Vantage SRM Web Client Guide](#).

The Windows Client Schedule List dialog provides the following toolbar options:
Note: For more information about the Scheduler and Schedule List, see the CA Vantage SRM Windows Client Guide and the Help on Windows online help system.

JCL Management

You can submit jobs manually from the Windows Client, either immediately or at a scheduled time. When you create a job (JCL stream) to submit, you determine the type of job being submitted, the number of steps, and so on. The job can involve your CA GMI enabled CA product, standard IBM utility programs, your own utility programs, or any combination of these. You can also use IEFBR14 jobs for testing purposes.

Note: Currently, the Web Client does not have a JCL Management feature.

The Windows Client helps you specify substitution variables (symbolic parameters) in the sample JCL you provide, allowing you to create generalized model JCL.

CA GMI provides two options for managing your JCLs:

- The Member Editor (Submit) function
- The JCL Model List feature

The Member Editor (Submit) Function

The Windows Client Member Editor (Submit) function under the z/OS menu in the Main Window can be used to manage your JCLs. You can use it to specify substitution variables (symbolic parameters) in your sample JCLs. It has a drag-and-drop feature that allows you to drag rows from object displays and drop them onto a JCL template in the Edit dialog. When you drag and drop the rows, the variables from the rows are substituted into the template. You can also use the Member Editor (Submit) function to submit jobs manually, either immediately or at a scheduled time.

Note: Currently, the Web Client does not have a Member Editor (Submit) function.

The following is a sample of the Windows Client New PDS Member Editor dialog that is displayed when you select the Member Editor (Submit) function under the z/OS menu option.
PDS Member Editor Dialog Toolbar Options

The PDS Member Editor dialog provides the following toolbar options:

![Toolbar Options](image)

Note: For more information about PDS Member Editor options, click the Help icon on the PDS Member Editor dialog Toolbar.

The JCL Model List Feature

The Windows Client JCL Model List feature helps you manage JCL. The JCL Model List feature provides the same functionality as the Member Editor (Submit) function however it presents your JCL working environment (the Object Table, the Associated JCL Members, the Substitution Variable List, and the PDS Member Editor) in one window so that working with your JCL is much easier.

Note: Currently, the Web Client does not have a JCL Model List feature.

You can use the Windows Client JCL Model List feature to select JCL models to be used by objects or a group of objects using pattern matching. These models can be used to perform actions or mainframe management functions in batch jobs. The models can contain object variables that are substituted upon request or at submit time.

You can start the JCL Model List feature two ways, from the Object Tree Pop-up Menu or from the object view Toolbar.

To start the JCL Model List feature from the Object Tree pop-up menu in the Windows Client

1. Right-click an object in the object tree.
   The Object Tree pop-up menu appears.
2. Click the JCL Model List option.
   The JCL Model List dialog appears.
**To start and use the JCL Model List feature from the object view Toolbar**

1. Click the object in the object tree.
   The Object view appears.

2. Click the down arrow next to the Definitions icon in the object view Toolbar.
   The Definitions drop-down menu appears.

3. Click the JCL Model List option.
   The JCL Model List dialog appears. The JCL Model List dialog displays the object data and the list of JCL members associated with that object in separate panes as shown in the following sample:

   ![JCL Model List for Volume Space Usage](image)

   The Object Table pane displays the object selected. You can use the object view menu options in the pane to change the object view, such as sort, filter, zoom, and so on.

   The Associated JCL Members pane displays the JCL models you have created and linked to the object selected. You can use the Associated JCL Members Action options to modify the JCL Model information displayed in the pane, add new JCL models, and to delete JCL Models.

   **Note:** For more information about the Associated JCL Members pane, click the menu bar Help option and select Help About Object.
4. Double-click a model line, and two additional panes appear in the JCL Model List dialog: the Substitution Variable List for the object, and the PDS Member Editor with the model JCL.

The following sample shows how the JCL Model List displays all 4 panes in the JCL Model List dialog.

![JCL Model List with panes]

Using the PDS Member Editor pane you can edit the model JCL, create new JCL Models, insert variables, substitute variables with object information, submit the JCL, and so on.

**Note:** For more information about PDS Member Editor options click the Help option on the PDS Member Editor pane Menu Bar.

5. Click your cursor in the JCL in the PDS Member Editor pane where you want a variable to be inserted, and then double click the desired variable in the Substitution Variable List pane.

The variable appears in the PDS Member Editor pane where you indicated.

6. Repeat step 5 until you have included all your variables in the PDS Member Editor pane.

Now you are ready to substitute the variables in your JCL with object line information.

7. Click a line or multiple lines in the Object Table pane, then drag-and-drop them into the PDS Member Editor.

When you do this, a new PDS Member Editor dialog is opened with the resulting JCL; that is, the field values from your selected object table lines are substituted into the variable locations in a copy of your JCL model in a new PDS Member Editor dialog.

8. Click the Submit icon in the PDS Member Editor Toolbar when your JCL is complete and you are ready to submit it.

A message dialog appears advising that your JCL has been submitted.

**Note:** For more information about working with the JCL Model List, see the *CA Vantage SRM User Guide*. 
User-Interface Object Action Options

The Actions option is only available for certain objects and it is used to perform actions on specific object items. The actions available for an object relate to specific functionality of the object being accessed.

Note: If the Windows Client Help on Object or the Web Client Object-object_name-Help for an object lists Actions, but the Actions menu option does not display any Actions, it is because your CA GMI license does not authorize you to use them.

Example: Display of the Action menu of the Volume Space Usage object

The following is a sample of the Volume Space Usage object Action menu displayed in the Web Client:
The following is a sample of the Volume Space Usage object Action menu displayed in the Windows Client:

![Volume Space Usage Action Menu](image)

**Note:** When object actions are performed, security checks are made with the proper access levels. The user ID for each security check will be either the user ID associated with the CA GMI started task, or the user ID that owns the script (the person who created or last modified it). For more information about the security system, see the description of system parameter SECURSCR in the *CA Vantage SRM Configuration Guide*.

**Display Actions Dialog Feature**

You can use the actions dialog feature to perform actions on certain objects.

**To start the Actions dialog feature**

1. Click an object in the Object Tree.
   
   An object in Table View appears in your user-interface window.

2. Select a line or group of object data in the object Table that you want to perform the action on.
   
   The line or lines of object data in the Table View is selected.

3. If you are using the Windows Client, click Actions in the Table View Menu Bar. If you are using the Web Client, click Actions in the object Menu Bar.
   
   The Actions drop down list appears.
4. Click the Action you want to perform. 

The Actions dialog appears.

**Note:** For more information about how to use the Actions dialog view the *Help on Window* online help system in the Windows Client or the *Navigation* online help system in the Web Client. For more information about an object and available object actions view the *Help on Object* online help system in the Windows Client or the *Object-object_name-Help* online help system in the Web Client. If the *Help on Object* for an object or the *Object-object_name-Help* online help system lists Actions, but the Actions menu option does not display any Actions, it is because your CA GMI license does not authorize you to use them.

**User-Interface Online Help Systems**

Both the Web Client and the Windows Client have two types of online help systems:

**Windows Client**

**Help on Window (Help About Window)**

Provides information on how to use Windows Client features and if you click Help About Window from a window or dialog Help menu option it provides help about the opened window or dialog. This online help system also has a search facility.

**Note:** From the object tree this help is called Help on Window and when you have a window open and you click the Help menu option this is called Help About Window.

**Help on Object (Help About Object)**

Provides object specific information. It includes a description of the object, actions available, and information about the object data fields in the object.

**Note:** If the *Help on Object* for an object lists Actions but the Actions menu option does not display any Actions it is because your CA GMI license does not authorize you to use them.

**Note:** From the object tree, this help is called Help on Object, and when you have the object open in a window and click the Help menu option, this is called Help About Object.

**To access the Windows Client Help on Window (Help About Window) online help system**

1. Click the Help icon (ображення) displayed in an open window or dialog.

The help topic that pertains to that window or dialog is displayed.

Most windows and dialogs also have a Help menu option where you can select Help About Window to display the help topic that pertains to that window or dialog is displayed.
You can also open this online help system from the main Windows Client menu by clicking the Help menu option and selecting CA SRM and CA Vantage Help Topics or by clicking the Help icon (蹉) in the main Windows Client toolbar.

**To access the Windows Client Help on Object (Help About Object) online help system**

1. Right-click on an object in the Object Tree dialog.
   The Object pop-up menu appears.
2. Click Help on Object.
   The Help on Object system appears showing the help page related to the object selected as shown in the following sample of the Help on Object for the Storage Groups object.

![Help on Object](image)

**Storage Groups**

The Storage Groups object provides a graphic and numeric description of space usage in each Storage Group. The value in the percent allocated column is rendered in color-coded bars. Each Storage Group is a collection of one or more volumes. They can be NFS, ELV, VMFS, CA Allocate or CA Vantage user defined Storage Groups.

The Storage Group with fixed name TOTAL VOL is generated by CA Vantage and contains totals for all volumes. It is not possible to zoom from this Storage Group.

**How The Object Data Is Created**

The data is collected at the interval specified in sysparm PAUSE_INTERVAL by scanning all online SAN/D volumes. The data is kept in memory and presented immediately when the object is executed.

These sysparms control which Pools/Storage Groups will be displayed:

- INCLVOLS, INCLVOL, INCLUDIR and INCLUDIR.

Sysparm MKPOLLAD has options to dynamically add spare volumes to storage groups.

**Available Actions**

- **Add SMS Volume**
  Add the first candidate volume in the SMSPOOL table to the selected SMS Storage Group.

**Example: Display help from an object view**

You can also access the Help on Object (Help About Object) and the Help on Window (Help About Window) online help systems from the Help menu item in the object view Menu Bar as shown in the following sample of the an object table view Menu Bar.
Web Client

Navigation Online Help

Provides information on how to navigate the Web Client and use Web Client features. If you click Help then Navigation from a window, wizard, or dialog, the online Help topic displayed provides help about the opened window, wizard, or dialog. This online help system also has an index and a search facility.

Object - object_name - Help

Provides object specific information. It includes a description of the object, actions available, and information about the object data fields in the object.

Note: If the Object - object_name - Help for an object lists Actions, but the Actions menu option does not display any Actions, it is because your CA GMI license does not authorize you to use them.

To access the Web Client Navigation online help system

Click Help and then Navigation in the object Menu Bar, or in the opened window, wizard, or dialog. The help topic that pertains to that open window, wizard, or dialog is displayed. The help topic displayed when you click Help and then Navigation in the object Menu Bar is the Welcome page.

You can also open this online help system by clicking Help in the top line of the main Web Client window.

To access the Web Client Object - object_name - Help online help system

Click Help and then Object - object_name - Help on the object Menu Bar. The Object - object_name - Help appears showing the help page related to the displayed object.
Chapter 2: Setting Up CA GMI

This chapter explains how to set up CA GMI.

This section contains the following topics:
- **CA GMI Components** (see page 61)
- **Install and Configure CA GMI** (see page 62)
- **Start and Log In to the Windows Client** (see page 64)
- **Define a z/OS Host** (see page 68)
- **Connect and Log In to the z/OS Host** (see page 70)
- **Define the Data Collection Mode** (see page 72)
- **Closing the Windows Client** (see page 74)

### CA GMI Components

CA GMI consists of the following two components:

**z/OS Server**
- Installed on the mainframe.

**User-Interface (PC) Clients**
- The following user-interface clients are available:
  - **Windows Client**
    - This client is a Windows-based user-interface. This client provides full functionality and when you install the Windows Client you also install the Config Client and the CA Vantage SRM documentation set. You can use the Config Client to set CA Vantage SRM parameters.

  - **Web Client**
    - This client is a web-based user interface. The client can be used from any PC with internet access to the web client application server. You can access the CA Vantage SRM documentation set from the web client. The current web client provides partial functionality compared to the Windows client.
  
  **Note:** Install the Windows client first and then the web client. The Windows client contains the Config client which you can use to set CA Vantage SRM system parameters.
Install and Configure CA GMI

3270-based interface (View 3270 Client)

This client provides partial functionality that is limited to:

- User-driven functionality of view and analysis
- Filtering and sorting, zooming
- Ability to initiate actions on selected entries

Note: The View 3270 Client is considered a character-based user-interface, not a graphic-based user-interface, so it is not discussed in this guide. For View 3270 Client installation and configuration information, see the chapter "Configuring CA GMI" in the CA Vantage SRM Configuration Guide. For more information about using the View 3270 Client, see the chapter "Navigating the View 3270 Client" in the CA Vantage SRM User Guide.

Install and Configure CA GMI

In order to use CA GMI you must install and configure both the z/OS component and at least one of the User-Interface (PC) Client components (you can use the Windows Client, the Web Client, or both).

Note: If you have already installed CA GMI components for one of the other CA GMI enabled products, there is no need to install the components again, however you must perform step 4 in the following procedure for the CA GMI qualified product. If you are installing the components for the first time, ensure that you have received the proper installation materials for the z/OS and the User-Interface (PC) Client components. If you do not have all the installation materials you need, then contact CA Support at http://ca.com/support.

To install and configure both components of CA GMI

Note: System software and hardware requirements for both components of CA GMI can be found in the CA Vantage SRM Installation Guide.

1. Install the z/OS server as described in the CA Vantage SRM Installation Guide.

   The z/OS server is installed on your z/OS system.

2. Install the Windows Client as described in the CA Vantage SRM Installation Guide.

   The Windows Client is installed on at least one PC.

   Note: When you install the Windows Client, you also install the CA Vantage SRM Config Client which you can use to set CA Vantage SRM system parameters. If you want to use the Web Client, we suggest you install it after you have completed step 8. However, you can install the Web Client after you have completed step 3 and to be able to use it to work with CA GMI enabled product objects you must complete step 4 for each CA GMI enabled product. For more information about installing, navigating, and using the Web Client, see the CA Vantage SRM Web Client Guide.
3. Configure the parts of the z/OS server that are common to all CA GMI enabled products as described in the chapter “Configuring CA GMI” in the *CA Vantage SRM Configuration Guide*.

   Common CA GMI parts of the z/OS server are configured on your z/OS system.

4. Configure the parts of the z/OS server that are specific to your CA GMI enabled product according to the chapter “z/OS Host Configuration” in this guide.

   Your CA GMI enabled product objects are defined for retrieving your CA GMI enabled product object data by the CA GMI user-interface.

   **Note:** If you want to use the Web Client you can install it now or after you complete step 8. For more information about installation, starting, navigation, and using the Web Client, see the *CA Vantage SRM Web Client Guide*.

5. Start the Windows Client according to the section *Start and Log in to the Windows Client* (see page 64).

   The Windows Client is up and running on your PC.

6. Define z/OS host connections as described in the section *Define a z/OS Host* (see page 68).

   At least one z/OS host is defined in your Host List.

7. Connect the Windows Client to a z/OS host and login as described in the section *Connect and Log In to the z/OS Host* (see page 70).

   The Windows Client is connected and logged in to a z/OS host. You can start using it to view and work with object data.

8. Define the Windows Client data collection mode as described in the section *Define the Data Collection* (see page 72).

   Object data is automatically displayed in the object view when you open an object.

**Note:** The latest version of the CA Vantage SRM documentation set is available at [http://ca.com/support](http://ca.com/support). However, you can install the Windows Client first (with no configuration) and then access the CA Vantage SRM documentation set. To access the CA Vantage SRM documentation set from the Windows Client click Start, Programs, CA, CA Storage Resource Manager, Documentation, and then Manuals - z/OS, or from the Windows Client main menu Help drop-down menu click Manuals - z/OS. The CA Vantage SRM documentation set consists of the following documents:

- *CA Vantage SRM Best Practices Guide*
- *CA Vantage SRM Configuration Guide*
- *CA Vantage SRM Installation Guide*
- *CA Vantage SRM Message Reference Guide*
- *CA Vantage SRM Reference Guide*
- *CA Vantage SRM Release Notes*
Start and Log In to the Windows Client

If you want to use the Windows Client for your CA GMI session then you must start it.

By default, when you start the Windows Client, you automatically log in as the ADMIN user (the default administrator), no Windows Client Login dialog appears, and the Windows Client Main Window appears. However, if this default was changed to require a specific user ID and password, the Windows Client Login dialog appears when you start the Windows Client and you must provide a valid user ID and password.

**Note:** For more information about creating and maintaining Windows Client logins, see the section User Manager in the *CA Vantage SRM Windows Client Guide*.

**To start and log in to the Windows Client**

1. Click Start, Programs, CA, CA Storage Resource Manager, and select Windows Client.

   The Windows Client Login dialog appears as shown in the following sample.

   ![Windows Client Login](image-url)
2. Type in your Windows Client User ID and Password and click OK.

The Windows Client Main Window appears with the Home Form dialog displayed as shown in the following sample.

To start the Windows Client, click Start, Programs, CA, CA Storage Resource Manager, and select Windows Client. If no Windows Client login is required, the Windows Client Main Window appears with the Home Form dialog displayed.
Windows Client Menu Bar and Toolbar Options

The top of the main window of the Windows Client has the following Menu Bar and Toolbar options:

Note: For more information about the Windows Client Menu Bar and Toolbar options, see the CA Vantage SRM Windows Client Guide or click the Help icon on the Windows Client Menu Bar.

The Windows Client View

Many Windows Client users prefer to close the Home Form dialog and display the Host List dialog and the Object Tree dialog.

To close the Windows Client Home Form dialog click the Close dialog icon located at the top right hand corner of the Home Form dialog shown in the following sample.

To display the Host List dialog click the Host List icon located in the Windows Client Toolbar. The following is a sample of the Host List dialog.
To display the Object Tree dialog click the Object Tree icon (łó) located in the Windows Client Toolbar. The following is a sample of the Object Tree dialog.

You can resize and move displayed dialogs in the Windows Client the same as you resize and move opened windows on your PC desktop. Arrange the Host List and Object Tree dialogs so they display as shown in the following screen capture sample.
Define a z/OS Host

After starting the Windows Client you need to connect the Windows Client to the z/OS server component. In order to connect the Windows Client to the z/OS server component, you must first define the z/OS server or servers that you plan to use. The Windows Client Host List feature is used to define z/OS server connections.

You can define as many z/OS servers as you want and you can simultaneously connect to as many z/OS servers as you want (as long you have installed and configured the z/OS server component on them).

To define a z/OS host

Note: The following procedure assumes you have started the Windows Client and the Host List dialog is not displayed. If the Host List dialog is already displayed then you can skip step 1.

1. Click the Host List icon ( ) in the Windows Client Toolbar.
   
   The Host List dialog appears as shown in the following sample.

   ![Host List dialog](image)

2. Click the New Host icon ( ) in the Host List dialog.
   
   The Host Definition dialog appears as shown in the following sample.

   ![Host Definition dialog](image)
3. Complete the Host Definition dialog, the field options are:

   **Host**
   Provides the Host Name displayed in the Host List dialog.

   **Agent Name**
   Provides the name of the agent that collects data from the host. Select z/OS if it is not already displayed.

   **IP Address**
   Defines the IP address or server name of the z/OS host to which you are connecting.

   **Port Number**
   Defines the port number of the z/OS host to which you are connecting.

   **User ID**
   (Optional) Provides the user ID, which is sent to the host in encrypted form. If you do not specify a user ID then you must enter it every time you try to connect the Windows Client to the z/OS host.

   **Password**
   (Optional) Provides the password, which is sent to the host in encrypted form. If you do not specify a password then you must enter it every time you try to connect the Windows Client to the z/OS host.

   **Note:** You also have the option of providing the z/OS host user ID and not the password when setting up your Host Definition; this is often done at sites where security policies require Passwords to be changed periodically.

   **Confirmation**
   Confirms the password, if you provide a password then you must provide the same password in the confirmation field.

   **Host Trace**
   (Optional) Creates a trace on the host of all the messages exchanged between the z/OS host and the Windows Client. For more information about this field click the Help icon.

   **PC Communication Trace**
   (Optional) Indicates if the system should save the messages relating to host-client communication in a log file. For more information about this field click the Help icon.

4. Click Test to test your connection information.

   The Windows Client advises you if your connection to the z/OS host is successful.
5. Click Save.

The Windows Client stores the host definition. The new host definition appears in the Host List dialog. The Host List dialog displays all your defined hosts and their connection status.

The following is a sample of the Host List dialog showing the different connection status icons.

**Host List Dialog Toolbar Options**

The Windows Client Host List dialog provides the following toolbar options:

**Connect and Log In to the z/OS Host**

After you start the Windows Client and have defined z/OS host connections, you can then connect the Windows Client to a z/OS host and log in to the z/OS host. Once that is done you can start using CA GMI.
To connect and log in to the z/OS host

**Note:** The following procedure assumes you have predefined your z/OS hosts and they are displayed in the Host List dialog. If you do not have predefined hosts in the Host List dialog then see the section Define a z/OS Host. If the Host List dialog is already displayed in your Windows Client window then skip step 1.

1. Click the Host List icon ( ![Host List icon](image1.png) ) in the toolbar.

   The Host List dialog appears. The following is a sample of the Host List dialog.

   ![Host List dialog sample](image2.png)

2. Select the host to which you want to log in to from the Host List dialog.

   The selected host definition is highlighted as shown in the following sample.

   ![Host List dialog sample](image3.png)

3. Click the Connect icon ( ![Connect icon](image4.png) ) in the Host List dialog toolbar.

   If your user ID and password were provided in the Host Definition dialog for the selected host, the Windows Client attempts to connect to the host. If the connection is successful then the connection status icon changes from the Not Connected icon ( ![Not Connected icon](image5.png) ) to the Connected icon ( ![Connected icon](image6.png) ). You can begin using CA GMI and you can skip step 4.

   If your user ID and password were not provided in the Host Definition dialog for the selected host, then the Host Login dialog appears as shown in the following sample dialog, and you must proceed to the next step.

   ![Host Login dialog](image7.png)
Define the Data Collection Mode

4. Enter a valid user ID and password in the Host Login dialog, and click OK.

    The Host Login dialog disappears.

    The Windows Client attempts to connect and log on to the z/OS host. When the
    connection and log on is complete, the connection icon in the Host List Dialog
    changes from the Connecting icon (connecting icon) to the Connected icon (connected icon), as shown in
    the following sample, and you can begin using CA GMI.

    Note: For more information about defining hosts and connecting to hosts, see the CA
    Vantage SRM Windows Client Guide or the online help.

Define the Data Collection Mode

CA GMI can be configured to collect data in either Automatic or Manual mode.

- In Automatic mode, object data is collected automatically when you open an object.
- In Manual mode, object data is only collected by the Windows Client when you click
  the Execute icon (execute icon) in the open object view Toolbar.

To define the data collection mode in the Windows Client

1. Click Tools in the Windows Client main window Menu Bar.

    The following is a sample of the Windows Client main window Menu Bar and
    Toolbar.
Define the Data Collection Mode

Chapter 2: Setting Up CA GMI

The Tools menu expands to display available items, as shown in the following sample:

2. Select Options from the Tools menu drop-down list.

The Global Options dialog appears, as shown in the following sample:

3. Select the General tab.

The General tab is displayed in the Global Options dialog.

4. Select View z/OS Execution.

A down arrow is displayed in the View z/OS Execution field.

5. Select the down arrow in the View z/OS Execution field.

A drop down list with choices of Automatic or Manual is displayed.
6. Select the mode you want the system to use and click OK.

   The Global Options dialog closes. When you select an object in the Object Tree the Windows Client will collect data based on the mode that you have selected.

   **Note:** The examples in this guide assume that Automatic mode is selected.

---

**Closing the Windows Client**

When you close the Windows Client it will log you off from your connected hosts. However, when you are finished working you should disconnect from hosts first then close the Windows Client.

**To close the Windows Client**

1. Select the host you are connected to in the Host List dialog.

   The selected host is highlighted.

2. Click the disconnect icon (🗑️) in the Host List dialog.

   The status icon of the selected host will change from connected (💻) to disconnected (🖥️).

3. Repeat steps 1 and 2 and close all host connections.

   All hosts displayed in the Host List dialog are displayed with the disconnected icon (🖥️).

4. Close the Windows Client by clicking the Close icon (❌) in the top right hand corner of the Windows Client.

   The Windows Client is no longer displayed.
Chapter 3: z/OS Host Configuration

Software Requirements

To use the CA SYSVIEW CA GMI component, check that your system has the following:

- CA Vantage SRM Client Release 12.6.0
- CA Vantage SRM Release 12.5.0 with CA SYSVIEW Version 13.0
- CA SYSVIEW User Address Space:
  - XSystem eXternal session Server task (XSXS)
    Provides CA GMI access to CA SYSVIEW using the external server to establish user sessions.
    Note: The XSYSTEM component must be specified in the GEN module. For more information about the GEN module, see the CA SYSVIEW Installation Guide.
- CAICCI component of CA Common Services provides the communications protocol.
  Note: For more information, see the CA SYSVIEW Administration Guide.
- IBM REXX Library:
  The SYSLOG and OUTPUT objects use compiled REXX programs, which require one of the following libraries:
  - Library for REXX on zSeries
  - Alternate Library for REXX
  The Alternate Library for REXX is free and lets you run REXX compiled code without having to purchase the Library for REXX on zSeries. The Alternate Library for REXX is included with z/OS V1R9, or you can access it from the following link:
How the Default Configuration Works

CA SYSVIEW does the following:

- Provides a user interface address space that establishes user sessions through interfaces like VTAM and CICS
- Establishes cross-system sessions from remote CA SYSVIEW interfaces

The user interface address space also handles sessions established through other CA applications like CA GMI which provides the GUI interface.

The following illustration shows the default configuration:

Equation 1: Default GMI configuration

The default CA SYSVIEW and GMI configuration is as follows:

- One CA GMI address space per CA SYSVIEW.
- CA GMI runs on the same system as CA SYSVIEW.
- The CA SYSVIEW user interface address space is auto discovered.
Alter the Default Configuration

The default configuration can be changed to run CA SYSVIEW and CA GMI in the following two alternate configurations:

- **Run CA SYSVIEW and CA GMI on different systems**
  Specify an override for the SVSRVSYS parameter to direct CA GMI to a CA SYSVIEW user interface address space on an alternate system.

  **Note:** This configuration is used for testing. The OUTPUT and SYSLOG objects acquire spool data directly from the GMI address space. If you run with this type of configuration, your OUTPUT and SYSLOG objects require that the JES2 subsystems are configured to run with a shared spool.

- **Run CA SYSVIEW and CA GMI on the same system and point to a specific user address space**
  Alter the SVSRVJOB parameter. Specify the name of the CA SYSVIEW user interface job that CA GMI should communicate with when running both:

  - Multiple copies of CA SYSVIEW
  - Multiple copies of the user interface.
Configure the CA GMI Interface

You do not need to override the default out-of-the-box configuration of the CA SYSVIEW GMI parameters. You only configure the CA GMI PROC.

Perform the following steps for each CA Vantage SRM z/OS host where CA SYSVIEW objects are to be available.

To configure CA GMI PROC

1. Concatenate the CA SYSVIEW GMI PARMLIB, hlq.CNM4GPRM, to the PARMS DD statement.
   The distributed library contains the following members:
   - **VPPDFU**
     Contains the CA SYSVIEW parameter definitions and default settings located in the distributed GMI PARMLIB member.
     You can override these default settings in member VKGPARMS in the users parmlib.
   - **VPCDFU**
     Contains the parameters used by the Host Configuration Client (HCC).
   - **VPOTFU**
     Contains the CA SYSVIEW Object Tree.

2. Concatenate the CA SYSVIEW load library, hlq.CNM4GBLOD, to the STEPLIB DD in the CA GMI PROC.

3. Configure the Help by concatenating the CA SYSVIEW SMP/E library hlq.CNM4GHLHP to the HELP DD in the GMI PROC.
   The CA SYSVIEW Object Help becomes available through CA GMI.

4. Configure the Messages by concatenating the CA SYSVIEW SMP/E library hlq.CNM4GMSG to the MSGLIB DD in the GMI PROC.
   The CA SYSVIEW messages become available through CA GMI.
To configure CA GMI parameters

1. Modify the member CONFIG in the users parmlib to support the CA SYSVIEW component by adding or uncommenting the following statement:

   COMP=SYSVIEW

2. If the Vantage/GMI parameter SECURSCR is set to Y:
   a. Modify the CA SYSVIEW GMI security parameter SVEXTSEC.
   b. Define an appropriate SAF security rule to authorize GMI to alter security context for scripts.

   For more information, see the topic Distributed Configuration Parameters (see page 81).

Your CA SYSVIEW GMI environment has been configured. Component startup messages similar to the following display:

   SYV0001I Component SYSVIEW Release and Build initialization started
   SYV0011I Component token 2F770F78.00000000.00000000.00000000
   SYV0016I Default SYSVIEW cross-system external server found.
       System ccisys Jobname sysvuser
   SYV0027I xxx objects defined for SYSVIEW build xxxx
   SYV0002I Component SYSVIEW initialization completed

   Note: If message SYV0027I is not issued, no CA SYSVIEW objects appear in the object tree. Verify that both CAICCI and the CA SYSVIEW user interface address space have started. Look for message SYV0017E indicating that the user address space was not found:

       SYV0017E Default SYSVIEW cross-system external server not found. System ccisys Jobname sysvuser

   After the CA SYSVIEW user address space and the XSystem eXternal session Server task (XSXS) are running, the CA SYSVIEW component task will:
   1. Discover the SYSVIEW cross-system external server on the next interval
   2. Build the CA SYSVIEW objects and issue message SYV0027I

   More information

   Distributed Configuration Parameters (see page 81)
Configure the CA SYSVIEW User Address Space

The CA SYSVIEW user interface address space must be configured to start the XSystem eXternal (XSXS) session server. The XSXS session server subtask provides CA GMI access to CA SYSVIEW using the external server to establish user sessions.

To configure the external interface, specify the XSYSTEM feature value in the CA SYSVIEW GSVIINST macro during installation.

F gmiaddr,SYSVIEW Command—Modify the Component Task

After the CA SYSVIEW Component task has started, you can modify the started task using the F gmiaddr command.

This command has the following format:

F gmiaddr,SYSVIEW,component-command

gmiaddr

Defines the name of the GMI/Vantage address space.

component-command

Specifies one of the following values:

STATUS

Displays the CA SYSVIEW Component task status by issuing message SYV0013I, and possibly a few other messages, when the task is active.

TIMEOUT=xxx

Controls the timeout value.

DEBUG=x

Controls debugging using the SVDEBUG parameter.

DEBUGRX=Y/N

Controls debugging using the SVDBGREX parameter.

OVERVIEW=Y/N

Controls whether the system overview information displays in the information area.

More information:

Distributed Configuration Parameters (see page 81)
Distributed Configuration Parameters

CA SYSVIEW distributes user modifiable parameters. To override or alter the distributed parameters, use the Config Client or update the VKGPARMS parmlib member in the Vantage parmlib data set.

More information:

Configure the CA GMI Interface (see page 78)
F gmiaddr, SYSVIEW Command—Modify the Component Task (see page 80)

The following are the distributed parameters and their defaults:

SVSRVJOB
Specifies the name of the CA SYSVIEW user interface address space with which the CA GMI address space communicates. Only specify SVSRVJOB when running multiple CA SYSVIEW user interfaces and you want to connect to a specific jobname.

Default: Blank. The CA SYSVIEW component of GMI discovers the local CA SYSVIEW user interface address space. CA SYSVIEW uses the first discovered interface when you are running multiple interfaces.

SVSRVSYS
Specifies the CAICCI system name where the CA SYSVIEW user interface address space is located.

Default: Blank. The CA SYSVIEW component of GMI discovers the local CA SYSVIEW user interface address space.

Note: If you point to a CA SYSVIEW user interface on an alternate system, the SYSLOG and OUTPUT commands only work if the GMI system and the remote CA SYSVIEW user interface system are in a JES2 shared spool configuration.
SYINTVL

Specifies the interval time in seconds that the CA SYSVIEW component of GMI verifies the status of the CA SYSVIEW user interface server. The interface is checked each interval. If the user interface is not available, GMI issues a message during each interval until the user interface becomes available.

During GMI and CA SYSVIEW component initialization, the CA SYSVIEW user interface must be available to define the CA SYSVIEW objects. If the CA SYSVIEW user interface address space is not available during initialization, the CA SYSVIEW component under GMI checks for its availability each interval. When it becomes available, the component defines the CA SYSVIEW objects at that time. After initialization, the component uses this interval to verify the status of the CA SYSVIEW user interface. The component issues a message when the interface is no longer available.

Default: 120
Minimum: 30
Maximum: 600

SVTIMOUT

Specifies the time in seconds the communication code waits for a response from the CA SYSVIEW user interface address space before timing out the request.

Default: 30
Minimum: 30
Maximum: 120

SVOVRINF

Controls whether to include CA SYSVIEW Overview information in the information area of the user interface.

Note: Overview information is not available for the SYSLOG and OUTPUT objects.

Valid Values:

- Y (Yes), include the overview data in the information section.
- N (No), do not include the overview data in the information section.

Default: N
The following are the distributed debugging parameters and their defaults:

**SVDBGREX**

Turns on REXX debugging, which generates messages that can be used for debugging the CA SYSVIEW component.

Only specify a value of Y when directed by CA Technical Support.

**Valid Values:**
- Y (Yes), turn on REXX debugging
- N (No), do not turn on REXX debugging.

**Default:** N

**SVDEBUG**

Specifies the debugging level to generate messages that can be used for debugging the CA SYSVIEW component.

Only specify a value other than zero when directed by CA Technical Support.

**Valid Values:** Zero through five

**Default:** Zero (0)
SVEXTSEC

The SVEXTSEC parameter only governs the RACROUTE CLASS name that is used. The name does not have to match the actual security product that is installed.

Specifies the external security product:

- RACF
- CA Top Secret
- CA ACF2

If the Vantage/GMI parameter SECURSCR is set to Y, the user ID of the user that creates a script is saved. When Vantage/GMI executes a script, the Vantage/GMI address space must have the authority to change the security context of the corresponding user session.

The CA SYSVIEW API does a RACROUTE call to validate that the Vantage/GMI address space user ID is authorized based on the following:

<table>
<thead>
<tr>
<th>SVEXTSEC Value</th>
<th>RACROUTE Class</th>
<th>RACROUTE Entity (Resource Name)</th>
</tr>
</thead>
<tbody>
<tr>
<td>RACF</td>
<td>FACILITY</td>
<td>SV.XAPI.ALTUSER.ccisyst.ssid.jobname</td>
</tr>
<tr>
<td>TOPS</td>
<td>CAGSVX</td>
<td>SV.XAPI.ALTUSER.ccisyst.ssid.jobname</td>
</tr>
<tr>
<td>ACF2</td>
<td>SYSVIEW</td>
<td>SV.XAPI.ALTUSER.ccisyst.ssid.jobname</td>
</tr>
</tbody>
</table>

**ccisyst**

The CAICCI system name of the system where the SYSVIEW user address space is running. The default configuration is that CA GMI and CA SYSVIEW are on the same system, so ccisyst would be the local CAICCI.

**ssid**

The subsystem name for SYSVIEW on the ccisyst system.

**jobname**

The job name of the SYSVIEW user address space.

SVLOGLVL

Specifies the API debugging level, which generates messages that can be used for debugging the CA SYSVIEW component.

Only specify a value other than four when directed by CA Technical Support.

**Valid Values:** One through seven

**Default:** Four
Chapter 4: Using CA SYSVIEW Objects

How Security Validation Works

The same user security is applied to the user accessing CA SYSVIEW through the client as they would through any CA SYSVIEW user interface. Users that do not have access to a command as established by CA SYSVIEW internal or external rules, cannot access that command on the client.

Client security validation works as follows:

1. The user logs on through the client.
2. The user goes through GMI user ID and password validation.
3. The user accesses a CA SYSVIEW object.
4. A user session is established in the CA SYSVIEW User Interface address space.
How Security Validation Works

The following diagram shows the GUI connections and the user tasks:

*Equation 2: GMI GUI Configuration*

![Diagram showing GUI connections and user tasks]

When a user does not have access to a field, security works as follows:

- Under a SYSVIEW 3270 interface, the field is not displayed.
- Under GMI, instead of displaying the actual data, the GUI displays static data in these columns according to the following data type of the field:
  - For character data, blanks display
  - For numeric data, zeros display
  - For the date, NONE displays
  - For the time, 00:00:00 displays
Use the GMI Windows Client GUI to Access CA SYSVIEW Objects

All CA SYSVIEW objects are included in the CA SYSVIEW folder of the Object Tree.

**Note:** Before you begin, make sure that the z/OS host that you want to connect to is up-and-running. For procedures on defining a z/OS Host, see the chapter Setting Up CA GMI.

**To access CA SYSVIEW objects**

1. Click Start, Programs, CA, CA Storage Resource Manager, and select Windows Client.

   The GMI Windows Client appears. The following is a sample of the GMI Windows Client main window Menu Bar and Toolbar.

   ![GMI Windows Client GUI](image)

2. Click the Host List icon in the GMI Windows Client main window Toolbar.

   The Host List dialog opens. The following is a sample of the Host List dialog.

   ![Host List](image)

3. Select the z/OS host that you want to connect to and click the Connect icon.

   If your user ID and password were provided in the Host Definition dialog for the selected host, the GMI Windows Client attempts to connect to the host. If the connection is successful then the connection status icon changes from the Not Connected icon to the Connected icon. You can skip to step 4.

   If your user ID and password were not provided in the Host Definition dialog for the selected host, then the Host Login dialog appears as shown in the following sample. You must proceed to step 4.

   ![Host Login](image)
Use the GMI Windows Client GUI to Access CA SYSVIEW Objects

Enter a valid user ID and password in the Host Login dialog, and click OK.

The Host Login dialog disappears.

The GMI Windows Client will attempt to connect and log on to the z/OS host. If the connection is successful then the connection status icon in the Host List dialog changes from the Not Connected icon to the Connected icon. GMI will collect information from the z/OS host that you have chosen to connect to.

4. Click the Object Tree icon in the GMI Windows Client main windows Toolbar.

The Object Tree dialog appears. The following is a sample of an Object Tree.

```
Object Tree

- Z/OS
  - Allocation Control
  - Automation and Logging
  - Backup and Archive Management
  - CA SYSVIEW
  - CA Vantage Internal Management
  - Catalog Management
  - Data Set Groups (Applications)
  - Data Set Management
  - Database Management
  - DFSMS Constructo
  - Distributed Sys Views From z/OS
  - Encryption Key Management
  - Hardware Errors - Disk/Tape
  - Performance Management (DASD)
  - RAID Devices
  - Storage Groups
  - Tape Resource Management
  - UNIX for z-Series
  - Volumes (DASD)
  - z/OS System Resources
```
5. Click the plus sign next to the CA SYSVIEW folder.

The CA SYSVIEW objects are displayed in the Object Tree, as shown in the following sample.

**CA SYSVIEW Object Tree**

The CA SYSVIEW object tree lets you easily view information for the CA SYSVIEW option or component.
Administration Object Tree

The Administration folder contains an object tree with both objects and subfolders that provide you with administrative information.

Example: CA SYSVIEW Administration Object Tree

```
[Diagram of Administration Object Tree]
```

Admin Subfolders and Objects

This CA SYSVIEW Administration section briefly describes the Administration objects and subfolders.

- Administration objects provide the following information:
  
  **ASADMIN - Address Space Administration Object**
  
  Displays information about the CA SYSVIEW address spaces running on your system. The status shows the various tasks running in those address spaces.

  **CALENDAR - Calendar Object**
  
  Displays a 12-month calendar for the current year.

  **CMDACT - Command Activity Object**
  
  Displays an hourly summary of command activity for the last 24 hours.

  **CMDUSAGE - Command Usage Object**
  
  Displays all CA SYSVIEW commands issued by all users after the last IPL.

  **SAFAUTH - SAF Authority**
  
  Displays a list of SAF resources and the corresponding security authorization for each resource.
TIMEZONE - Time Zones Object
Displays information about time zones as defined in the input list.

USERACT - User Logon Activity
Displays an hourly summary of CA SYSVIEW user and task session activity for the last 24 hours.

USERS - Product Users Object
Displays information about all users in session with CA SYSVIEW, including data from multiple systems.

XSUSER - XSystem Users Object
Displays information about users in cross-system sessions.

The objects in the subfolders provide the following information:

Audit
This subfolder contains objects that display the following audit information:
- Audit event definitions
- Audit event records
- Command activity
- Command usage

Capture
This subfolder contains objects that display the following capture information:
- List of captured events
- Contents of a capture data set
- Capture index maintenance activities
Configuration

This subfolder contains objects that display the following configuration information:

- Feature definitions
- Logical groups
- Lists the dataspaces in use
- Product module status
- Scheduled events
- Translation table sets
- Translation tables
- Variable-length fields
- User and system variables

Help

This subfolder contains objects that display the following online help information:

- Product release changes
- Help topics
- Search online help topics
- Help information
- Message definitions

Libraries

This subfolder contains objects that display the following information about your CA SYSVIEW libraries:

- CLIST libraries
- DATALIB list
- Library Cache
- Library Viewer
- Product Libraries
- PARMLIB Libraries
- External Applications
Status

This subfolder contains objects that display the following status information:
- Grande storage area
- Activity log
- Product status
- Product users

The Status XSystem subfolder that contains objects that display the following cross-system information:
- Cross-system list
- Cross-system users
- Cross-system status

zOS Object Tree

The z/OS object tree contains subfolders that provide you with z/OS monitoring and management information.

Example: CA SYSVIEW z/OS Object Tree

- zOS
  - Address Space
  - Coupling Facility
  - CPU
  - Datasets
  - Devices
  - DFSMS System Managed Storage
  - Enqueues
  - Logger
  - Paging and Swapping
  - Performance and Status
  - RACF Resource Mgmt Facilities
  - SMF System Management Facilities
  - Storage
  - SYSPLEX
  - System
  - Utilities
  - USS
  - VLM
The z/OS subfolders provide objects that display the information unique to z/OS.

**Address Space**

The objects in this subfolder show information about a single address space:

- Address space monitoring
- Allocated data sets and devices
- Loaded modules
- Storage
- Tasks

*Note:* For information about how to switch address spaces, see the section Input Lists.

**Coupling Facility**

This subfolder includes the following statistics:

- Configurations
- I/O paths
- Processors
- Structures
- Users

**CPU**

This subfolder includes CPU utilizations.

**Datasets**

This subfolder includes system data set information.

**Devices**

This subfolder includes the following statistics:

- Device allocations
- Catalogs
- I/O configurations
- Volumes
- DASD and tape units

**DFSMS System Management Storage**

This subfolder includes the following statistics:

- SMS volumes
- Data and management classes
- Storage groups and classes
Enqueues

This subfolder includes enqueue conflict information.

Logger

This subfolder includes the following statistics:
- Data logs
- Log stream connections and definitions
- Job and sysplex connections
- Sysplex log data

Paging and Swapping

This subfolder includes the following statistics:
- Virtual storage pages
- Page data sets and frame tables
- System paging and swapping

Performance and Status

This subfolder includes the following statistics:
- Performance
- Monitoring
- Status
- Exception alerts

RMF Resource Management Facilities

This subfolder includes the following statistics:
- Storage
- Capacity
- Jobs
- LPARs
- Data sets
- Processors
SMF System Management Facilities
This subfolder includes the following statistics:
- SMF data sets
- Data collection
- Logs
- Record type definitions
- CAISMF intercepts

Storage
This subfolder includes the following statistics:
- Common, real, private, virtual, system, and subpool storage
- Data spaces
- Allocated cell pools

SYSPLEX
This subfolder includes the following statistics:
- Auto restarts
- Couple data sets
- Groups
- Members
- Paths
- Pending messages
- Systems
- Administration utility interface
System

This subfolder includes the following statistics:

- Address spaces
- System consoles
- IRLM system and locks
- LOGREC history
- Systems overview and trace tables
- VTAM extended commands and column lists
- WTO action messages and replies

This subfolder contains the following subfolder:

System Definitions

The objects in this subfolder contain information related to the definition of the z/OS operating system.

Utilities

This subfolder includes the following statistics:

- AMBLIST utility
- IDCAMS command facility
- I/O configuration data

USS

This UNIX System Services subfolder includes the following statistics:

- List address spaces and directory entries
- Mounted file systems
- Open files
- Processes
- Threads
- Resource monitor data
- System configuration
- Groups
- Users
- IPC information
WLM

This Workload Manager subfolder includes the following statistics:

- Workload activity
- Address spaces
- Application environments
- Policies
- Response times
- Enclaves
- Resources
- Rules
- System information

CICS Object Tree

The CICS object tree contains objects and subfolders that provide you with CICS monitoring and management information.

Example: CA SYSVIEW CICS Object Tree

```
- CICS
  - CICSLIST - CICS Address spaces
  - CALERTS - CICS Exception Alerts
  - Administration
  - File Resources
  - Historical Collection
  - Monitoring
  - Java Virtual Machines
  - Resources
  - Status
  - Storage
  - System definitions
  - Tasks and Transactions
  - Temporary storage
  - DE2, IMS, and MQ
  - CA Datacom CICS Service Facility
```
The CICS subfolders provide objects that display information unique to your CICS system.

Administration
This subfolder includes the following statistics:
- Auto response times
- Configuration options
- Dump management
- Transaction groups
- Data loggers
- Transaction options

File Resources
This subfolder includes the following statistics:
- File requests and control tables
- VSAM file performance
- Local shared resource buffers and pools

Historical Collection
This subfolder includes the following statistics:
- Hourly transactions
- System interval analysis
- Transaction log summaries and intervals
- Exception and data logs

Monitoring
This subfolder includes the following statistics:
- Exception alerts
- State and threshold definitions
- Resource status summary
- Monitor variables

Java Virtual Machines
This subfolder includes the following information:
- JVM programs
- Java virtual machines
- JVM servers
Resources

This subfolder includes the following statistics:

■ Channels
■ Containers
■ Directory domain elements
■ Document handler templates
■ Exit program blocks
■ Global user exits
■ Journal information and models
■ Libraries
■ Mode names
■ Pipelines
■ Program and terminal statistics
■ Remote system entries
■ TCP/IP sockets and socket users
■ Transient data queues and statistics
■ Interval timers
■ Web services

Status

This subfolder includes the following statistics:

■ Automatic initiate descriptors
■ Domains
■ Dump statistics
■ Enqueues and enqueue pools
■ Domain gates
■ Interval control elements
■ Lifetime range statistics
■ Lock managers
■ Monitor domains
■ Resource status summary
■ Internal trace tables
Chapter 4: Using CA SYSVIEW Objects

- External security users
- Degradation wait analysis

Storage

This subfolder includes the following statistics:
- Dynamic storage areas
- DSA extents
- Dynamic storage elements and subpools
- Subspace areas
- Symbols

System definitions

This subfolder includes the following statistics:
- Monitor control tables
- System initialization and recovery tables
- SIT initialization parameters

Tasks and Transactions

This subfolder includes the following statistics:
- Kernel tasks and task table entries
- Active tasks
- Transaction summary and classes
- Units of work

Temporary storage

This subfolder includes the following statistics:
- Summary information
- Models
- Pools
- Queues

DB2, IMS, and MQ

This folder includes the following statistics:
- DB2 connections, connection state blocks, and entries
- IMS DB controls
- MQ connections and tasks
CA Datacom CICS Service Facility

This subfolder includes the following statistics:

- TCB use, tasks, activity, and waits
- Return codes
- TCB start I/O
- Load module list
- MUFs
- Generation options
- Request statistics
- URT file tables
- Trace
- URTs
- Concurrent users

JES Object Tree

The JES object tree contains objects and subfolders that provide you with JES monitoring and management information.

Example: JES Object Tree
The JES subfolders provide objects that display information unique to your JES system.

**Job Management**

This subfolder includes the following statistics:

- APPC Output Queues
- Summary of input job priorities
- Job classes and summaries
- Status of JES and WLM Initiators
- Output files
- All job queues
- Job output
- Job step summary

**Output Management**

This subfolder includes the following statistics:

- APPC Output Queues
- Destination IDs
- Job summaries
- Network paths
- Remote devices
- NJE (network job entry) and RJE (remote job entry) lines
- Output files
- Jobs on the held output queues
- All job queues
- All output queues
- JES Nodes
- Output classes and descriptors
- Job output file contents
Device Management

This subfolder includes the following statistics:

- Internal readers
- Checkpoints
- Logons
- Paths
- Devices
- Sessions
- Lines
- Nodes
- Offloaders
- Printers
- Punches
- Readers
- Spool Volumes

Databases Object Tree

The Databases object tree contains objects and subfolders that provide you with monitoring and management information for the databases.

Example: Databases Object Tree

CA Datacom

The CA Datacom object tree contains objects and subfolders that provide you with monitoring and management information.

IMS

The IMS object tree contains objects and subfolders that provide you with IMS monitoring and management information.
Network Object Tree

The CA SYSVIEW Network object tree contains objects and subfolders that provide you with monitoring and management information.

Example: Network Object Tree

```
Network
   + Communications Storage Manager
   + Enterprise Extender
   + TCP
   + VTAM
```

The Network subfolders provide objects that display information unique to your network environment.

Communications Storage Manager

This subfolder includes the following statistics:

- Global buffer pools
- Global storage owners
- CSM status

Enterprise Extender

This subfolder includes the following statistics for the Enterprise Extender function of Communications Server for z/OS:

- Connection information
- Summary information

TCP

This subfolder includes the following:

- Monitoring alerts and definitions
- Resources and statistics

VTAM

This subfolder includes the following:

- Monitoring alerts and definitions
- Resources and statistics
WebSphere MQ Object Tree

The CA SYSVIEW WebSphere MQ object tree contains objects and subfolders that provide you with monitoring and management information.

Example: CA SYSVIEW WebSphere MQ Object Tree

```
WebSphere MQ
  MQLIST - MQ Subsystem List
  MQALERTS - MQ Exception Alert
  Configuration
  Status
  Resource Management
  Channels
  Queues
  Publish Subscribe
  Historical Requests
  Monitoring
  DB2 Activity
```

The WebSphere MQ subfolders provide objects that display information unique to your WebSphere MQ environment:

Configuration

This subfolder includes the following statistics:

- Authentications
- Channel definitions
- Queue managers
- Names lists
- Processes
- Queues
- Page sets
- Storage classes
- Parameter settings
- Subscriptions
- Topics
Status
This subfolder includes the following statistics:
- Exception alerts
- Active and Indoubt threads
- Cluster and Distributed queue managers
- Channel status
- Dead letter queues
- Handles
- Security
- Traces
- Topic users
- Queue and MQ Users

Resource Management
This subfolder includes the following statistics:
- Active Logs
- Buffers
- Log Manager
- Page sets
- Performance

Channels
This subfolder includes the following statistics:
- Definitions
- Status
- Client and Server Connections
- Requesters
- Senders
- Receivers
Queues

This subfolder includes the following statistics:

- Queue users and status
- Alias
- Clusters
- Local, remote, model, and event queues

Publish Subscribe

This subfolder includes information about WebSphere MQ publish and subscription statistics. The command requires WebSphere MQ 7.0 or above.

Historical Requests

This subfolder includes historical requests by jobs, objects, and additional request information.

Monitoring

This subfolder includes the following statistics:

- Monitor, state, and threshold definitions
- Monitor variables

DB2 Activity

This subfolder includes the following statistics:

- Manager activity
- Server tasks

CA Common Services for z/OS Object Tree

The CA Common Services for z/OS object tree objects provide monitoring and management information unique to your CA Common Services for z/OS environment.

Example: CA Common Services for z/OS Object Tree

```
<table>
<thead>
<tr>
<th>CA Common Services for z/OS</th>
</tr>
</thead>
<tbody>
<tr>
<td>CAICCI - CCI Inquiry</td>
</tr>
<tr>
<td>CAILMP - LMP Information</td>
</tr>
<tr>
<td>CAIRIM - RIM Installed Products</td>
</tr>
<tr>
<td>CAISMF - CAISMF SMF Intercepts</td>
</tr>
</tbody>
</table>
```
CA MIM Object Tree

The CA MIM object tree contains objects that provide you with monitoring and management information.

Example: CA MIM Object Tree

CA Roscoe Object Tree

The CA Roscoe object tree contains objects that provide you with monitoring and management information.

Example: CA Roscoe Object Tree
Use the Online Help Systems for More Information

You can access two types of online help systems from the GMI Windows Client:

**Help on Window**

Provides information about how to use GMI Windows Client features.

**Help on Object**

Provides object specific information, including information about the object data fields in each object.

**Note:** The online help is generated from the standard CA SYSVIEW online help. This online help can contain references to parameters, fields, and notes that pertain only to the 3270 interface.

To access the Help on Window online help system

1. Right-click on an object in the Object Tree dialog.

The Object pop-up menu appears as shown in the following sample.
2. Click HELP on Window
   The GMI Windows Client online help system appears showing the online help page for the window from which the Help on Window was selected.

To access the Help on Object online help system
1. Right-click on an object in the Object Tree dialog.
   The Object pop-up menu appears.
2. Click Help on Object
   The Help on Object appears showing the online help page for the selected object, which in this sample is ASADMIN.

Example: Display online help from an object view
You can access the Help About Object and the Help About Window from the Help menu item in the object view Menu Bar. This access is shown in the following sample of the CA SYSVIEW ASADMIN Address Space administration menu.
**Display the Information Area of an Object**

The information area is present on some of the CA SYSVIEW displays and contains information unique to the object (command). The information area length is from 1 to 16 lines.

**To display the information area**

1. Go to the object tree and click on an object.
2. Select the View Info Area icon on the open object view toolbar.

**Example: Information Area**

![Information Area Display](image)

---

**Table: Information Area**

<table>
<thead>
<tr>
<th>Type</th>
<th>Spin</th>
<th>Key</th>
<th>Addr</th>
<th>Len</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>CSA</td>
<td>227</td>
<td>34F05000</td>
<td>0000A000</td>
</tr>
<tr>
<td>9</td>
<td>CSA</td>
<td>227</td>
<td>352AA000</td>
<td>00001000</td>
</tr>
<tr>
<td>10</td>
<td>CSA</td>
<td>227</td>
<td>352AB000</td>
<td>00001000</td>
</tr>
<tr>
<td>11</td>
<td>CSA</td>
<td>227</td>
<td>352AC000</td>
<td>00001000</td>
</tr>
<tr>
<td>12</td>
<td>CSA</td>
<td>227</td>
<td>352AD000</td>
<td>00001000</td>
</tr>
<tr>
<td>13</td>
<td>CSA</td>
<td>227</td>
<td>352AE000</td>
<td>00001000</td>
</tr>
<tr>
<td>14</td>
<td>CSA</td>
<td>227</td>
<td>352AF000</td>
<td>00001000</td>
</tr>
<tr>
<td>15</td>
<td>CSA</td>
<td>227</td>
<td>352B0000</td>
<td>00001000</td>
</tr>
</tbody>
</table>
Specify Parameters Using the Input List

CA GMI uses the input list to pass parameters to CA SYSVIEW objects.

**Follow these steps:**

1. Select the Input List icon on the object view toolbar.
   The Input List dialog opens.
2. Specify input parameter settings for the object.

The input list data for CA SYSVIEW objects uses a keyword-parameter pair format:

**KEYWORD parameters**

Keyword is either:
- ASID
- **SYSVIEW Option** (CICS, IMS, MQ, DATACOM, or ROSCOE)
- PARM (or *command_name* or blank)

ASID and **SYSVIEW Option** are used to control the switching to a specific address space.

PARM is used to pass parameters to CA SYSVIEW commands.

The following sample shows the CTRANS object keywords and parameters.

**ASID xxxxx | nnnnn. | jobname | jnnnnn**

**CICS jobname**

**{CTRANS | PARM}* {Local | Global}**

**{SYSTEM | INTERVAL | TOTAL}**

* - Optional. If you do not specify either the command name or PARM, the parameters are assumed to be object parameters.

**Examples: Passing CTRANS parameters**

The following examples show switching modes and address spaces in the CICS Transaction Summary display.

- This example changes the mode from global to local:
  
  **CTRANS Local**
  **PARM Local**
  **Local**
Specify Parameters Using the Input List

- This example changes the mode from local to global:

  CTRANS Global
  PARM Global
  Global

- This example changes the default address space to SYSVC510 and mode to global:

  ![InputList for CICS transaction summary](image)

After the object executes, the CICS transaction summary data displays for the CICS SYSVC510 region and GLOBAL mode.

![Info Area: CICS transaction summary](image)

For the address space switchable objects, the Info Area usually contains the name of the address space in focus.

For the address space switchable objects, the Info Area usually contains the name of the address space in focus.
Status Fields

CA SYSVIEW commands on the 3270 can have a status that is reflected as color. Under GMI, a text string in a separate field named `fieldname`:

- Represents the status for a field
- Provides the status for the field it follows

Under GMI, CA SYSVIEW objects can contain special fields related to status:

- `:fieldname` fields contain the status of the individual field. Values display in character format.
- RowStat field represents the highest status for any field in the entire row. Values display in character format.
- RowStatLvl field represents the highest status for any field in the entire row. Values display in numeric format.

`:fieldname` Status Field

The following status field can appear in CA GMI objects:

`:fieldname`

Provides a status field for the field that it follows. For example, the field R-Stg displays first followed by the status field `:R-Stg`.

The `:fieldname` status fields are character fields and can contain the following values:

- Blank
- NORM
- HIGH
- WARN
- PROB
Example: Comparison of :R-Stg on the GMI GUI and the R-Stg on the 3270.

The following sample ACTIVITY display shows the R-Stg field followed by the :R-Stg status field displaying the status values of PROB and WARN.

This sample shows that the R-Stg colored problem status of red on the 3270 corresponds to the :R-Stg field (:fieldname) on the CA GMI GUI.
RowStat and RowStatLvl Status Fields

You can implement the functionality of CA SYSVIEW CONDITION selection processing under GMI. The following two fields appear on the objects that contain fields (:R-Stg field) with statuses:

**RowStat**

Displays in character format the highest level status for all fields in a row. The status can contain one of the five values previously listed. This field is great for displaying the row level status but does not sort well.

**RowStatLvl**

Displays a numeric representation of the highest status for the row. This field can be used with the GMI filter function to filter on the numeric row level status. For example: RowStatLvl >= 3 displays only status levels of 3 and 4, RowStatLvl =4 displays only rows with a status value of 4.

Status Values are as follows:

- 0 - No status
- 1 - Normal (NORM)
- 2 - High (HIGH)
- 3 - Warning (WARN)
- 4 - Problem (PROB)

You can use the RowStatLvl field to sort the row status with descending status, so that all of your highest severity rows display first.

**Example: RowStat and RowStatLvl**

<table>
<thead>
<tr>
<th>Jobname</th>
<th>PctCpu</th>
<th>PctPend</th>
<th>CPUT%</th>
<th>vCPUT%</th>
<th>RowStat</th>
<th>RowStatLvl</th>
</tr>
</thead>
<tbody>
<tr>
<td>VANGA1</td>
<td>0.00000</td>
<td>0.00000</td>
<td>1.10</td>
<td></td>
<td>PROB</td>
<td>4</td>
</tr>
<tr>
<td>YUASTO</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.25</td>
<td></td>
<td>PROB</td>
<td>4</td>
</tr>
<tr>
<td>SYSVAA</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.00</td>
<td>vWARN</td>
<td>WARN</td>
<td>3</td>
</tr>
<tr>
<td>SCHAM06</td>
<td>0.00000</td>
<td>0.00000</td>
<td>40.45</td>
<td>vWARN</td>
<td>WARN</td>
<td>3</td>
</tr>
<tr>
<td>QANM1</td>
<td>0.00000</td>
<td>01:02:633</td>
<td>1.50</td>
<td>vWARN</td>
<td>WARN</td>
<td>3</td>
</tr>
<tr>
<td>B61HDEP</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.10</td>
<td>vWARN</td>
<td>WARN</td>
<td>3</td>
</tr>
<tr>
<td>UESRI01</td>
<td>0.00000</td>
<td>0.00000</td>
<td>47.00</td>
<td>vWARN</td>
<td>WARN</td>
<td>3</td>
</tr>
<tr>
<td>SYSVAA</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.00</td>
<td>vWARN</td>
<td>WARN</td>
<td>3</td>
</tr>
<tr>
<td>TSS</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.70</td>
<td>vWARN</td>
<td>WARN</td>
<td>3</td>
</tr>
<tr>
<td>NET</td>
<td>0.00000</td>
<td>0.00000</td>
<td>2.70</td>
<td>vWARN</td>
<td>WARN</td>
<td>3</td>
</tr>
<tr>
<td>SVD91CR</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.05</td>
<td>vWARN</td>
<td>WARN</td>
<td>3</td>
</tr>
<tr>
<td>SYSVAA</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.00</td>
<td>vWARN</td>
<td>WARN</td>
<td>3</td>
</tr>
</tbody>
</table>
Factory User Views and Solution

CA SYSVIEW provides CA GMI factory-supplied User View and a Solution that customize the presentation of data. You can modify them and define new ones to meet your specific criteria.

More information:
Supplied User Views (see page 118)
Supplied SYSVIEW System Overview Solution (see page 119)

Supplied User Views

CA SYSVIEW objects contain user views that are shipped with the product. These views correspond to the formats shipped with CA SYSVIEW. User-defined views appear under the source object for which that are defined.

Example: User Views Supplied for the Object ASADMIN

This example shows factory-supplied user views that provide Configuration, CPU, and Storage information for the object ASADMIN - Address Space Admin.
Supplied SYSVIEW System Overview Solution

CA SYSVIEW supplies a SYSVIEW System Overview solution that contains CA SYSVIEW objects related to system health and performance. The SYSVIEW System Overview solution corresponds to the SYSVIEW Overview Menu on the 3270 interface.

When you select Solutions from the Desktop Layout menu, you can see the SYSVIEW System Overview solution listed in the secondary menu. Clicking the SYSVIEW System Overview solution opens it.

Example: SYSVIEW System Overview Solution

This example demonstrates the SYSVIEW System Overview solution included in the list of available solutions and the SYSVIEW System Overview solution menu.
Object and Line Actions

Object Actions are CA SYSVIEW subcommands that issue an action related to the command as a whole, like an APFLIST ADD.

Line actions are equivalent to CA SYSVIEW line commands.

Line actions let you do the following:
- Issue an action on a specific row, like to cancel a job.
- Alter fields on the display

Example: Object and Line Actions

This example shows an Actions drop down menu.

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>RECUR</td>
</tr>
<tr>
<td>2</td>
<td>CAPMANT RECUR</td>
</tr>
<tr>
<td>3</td>
<td>CICS001 RECUR</td>
</tr>
<tr>
<td>4</td>
<td>LGDORE RECUR</td>
</tr>
</tbody>
</table>

Object Actions

Object Actions are only available for certain objects and are used to let CA SYSVIEW subcommands issue an action related to the object. The object actions available for an object relate to specific functionality of the object, like adding a data set to the APFLIST.

To add a data set name and volser to the APFLIST using the APFLIST Object

1. Select Add Dataset from the list of Object Actions.
The Object Action Parameter dialog displays.

2. Fill in the parameters, which is in this example are the data set name and volser number, and click the Accept button.

The dialog refreshes and shows the results; in this case the message confirms the entry is added.

**Example: Data Set Name and Volser added to the APFLIST Object**

This example shows the new data set name and volser included in the APFLIST Object display.

**Note:** The object display may automatically update. A message appears instructing you to refresh the object display to see the results.
Use Line Actions to Affect Rows and Fields

Line Actions are equivalent to CA SYSVIEW line commands. You can execute line actions by selecting lines in the table, and then selecting the action you want to perform in the Action menu.

Line actions let you do the following:
- Initiate an action on a specific row or set of rows, like to cancel a job
- Alter fields, the same as typing over a value in CA SYSVIEW on z/OS

Follow these steps:

1. Select the rows you want to change and right-click.
   The Actions drop-down list displays the available line actions and, if available, the alter field line actions that you can perform on the selected rows.
2. Click the action you want to perform on the lines that you selected.
   The dialog displays where you can accept, stop, exit, or access online help.
3. Click Accept All
   The action processes, the dialog refreshes, and the results display.
Examples: Line Actions Dialog and Alter Field

- The following example shows using line actions to delete lines in the object.
Troubleshooting

GMI Graph Displays Incorrectly

**Symptom:**
Decimals do not display in our graphs. All graph zooms have the decimal fields removed.

**Reason:**
The GRAPH command under CA GMI does not display decimal places. Any graphed values with decimal places show as whole numbers.

**Solution:**
You could consider where the decimal place belongs when reading the graph. For example, millisecond contains three decimal places, microsecond contains six decimal places, and so on.
GMI Zooms Match All Criteria

**Symptom:**
When you zoom to an object in the Zoom list, the zoom matches all rows (fields) on the destination object when the column is blank.

**Reason:**
Zooms must match one field from the source object to a corresponding field on the destination object. If the source object field is blank, zoom matches all rows on the destination object. This match usually occurs because the zoom does not apply to the selected object.

For example, the SPACE object lets you zoom to the SMSGROUP objects. If the volume from the SPACE object is not SMS managed, the SMS fields are blank. You do not need to zoom to the SMSGROUP for such a row. When you do select the SMSGROUP zoom, the result shows all groups matching.

Line or Object Action Failed

**Symptom:**
I receive the following message when attempting to initiate line or object actions:

SYV0044E Object not last to execute or session timed out

**Reason:**
A line or object action was attempted on an object and the action could not be executed due to one of the following reasons:

- The object must be the most recent object retrieved from CA SYSVIEW to ensure that its state has not changed.
- The CA SYSVIEW session has timed out and the object state is no longer valid.

**Solution:**
Refresh the object and try the action again.
Messages from CAICCI Need Explained

Symptom:
I received the following error message from CAICCI and do not know what it means:
CCI Error R=xx RC=xxxxxxxx

Solution:
See the CA Common Services for z/OS Message Reference for error message explanations.

Messages from the Server Need Explained

Symptom:
I receive messages from the CA SYSVIEW server and do not know why they are being issued. For example, GRPH002E.

Solution:
You can use the LISTMSGS object to look up the messages. If the message is found, do one of the following:
- Double-click to zoom to the Help object
- Use the Help object directly and specify the message ID as input in the input list dialog
Index

| A | access CA SYSVIEW objects • 87 |
|   | actions |
|   | actions, line actions • 122 |
|   | dialog feature • 56 |
|   | object actions dialog • 120 |
|   | additional graph view options • 27 |
| C | CA GMI |
|   | access to basic CA Vantage SRM objects • 9 |
|   | components • 61 |
|   | introduction • 7 |
|   | software and hardware requirements • 62 |
|   | standard features • 11 |
|   | Web Client • 7 |
| CA SYSVIEW | CA SYSVIEW, configuring • 78, 80 |
|   | information area of a display • 112 |
|   | object tree • 89 |
| CA Vantage SRM | access to basic objects • 9 |
|   | documentation set • 62 |
|   | color coding reports • 37 |
|   | configurations of the z/OS Host • 76, 77 |
|   | connection status, z/OS host • 68 |
|   | customizing reports • 42 |
| D | data collection mode • 72 |
| Dialogs | color coding feature • 37 |
|   | Filter • 31 |
|   | Global Options • 72 |
|   | Host Definition • 68 |
|   | Host List • 68 |
|   | Host Login • 70 |
| JCL Model List • 53 | JCL Model List • 53 |
| Member Editor toolbar options • 52 | Member Editor toolbar options • 52 |
| Output Record • 43 | Output Record • 43 |
| PDS Member Editor toolbar options • 52 | PDS Member Editor toolbar options • 52 |
| Printer Destination • 46 | Printer Destination • 46 |
| Schedule List • 51 | Schedule List • 51 |
| Sort • 33 | Sort • 33 |

- disconnecting from a z/OS host • 74
- documentation set, CA Vantage SRM • 62

| F | factory settings, return a table view to factory settings • 15 |
|   | filters |
|   | Filter option • 30 |
|   | filtering a table • 30 |
|   | filters, Filter dialog toolbar options • 31 |
|   | filters, how filters work • 31 |

| G | Global Options dialog • 72 |
|   | graph type, change • 27 |
|   | graph views |
|   | change graph colors • 27 |
|   | decrease number of items displayed • 27 |
|   | graph view toolbar options • 27 |
|   | increase number of items displayed • 27 |
|   | multiple colors • 27 |
|   | object graph view • 26 |
|   | quick change graph type • 27 |

| H | hardware and software requirements for CA GMI • 62 |
| help | Help on Object (Help About Object) • 58 |
|   | Help on Window (Help About Window) • 58 |
| Host Definition dialog • 68 | Host Definition dialog • 68 |
| Host List dialog • 68 | Host List dialog • 68 |
| Host Login dialog • 70 | Host Login dialog • 70 |

| I | increase or decrease number of items displayed, graph view • 27 |
| Info Area • 14, 112 | Info Area • 14, 112 |
| Input List • 14 | Input List • 14 |
| install and configure CA GMI • 62 | install and configure CA GMI • 62 |
| introduction • 7 | introduction • 7 |

| J | JCL management • 52 |
designer • 40  
objects • 40  
totals and statistics • 33  
system software and hardware requirements for CA GMI • 62  

T  
table view  
  additional table view options • 15  
  input list • 14  
  move the freeze column line • 15  
  quick color code a column • 15  
  quick find in column • 15  
  quick sort on columns • 15  
  return a table view to factory settings • 15  
  table view toolbar options • 14  
  view info area • 14  
Totals option • 35  

U  
user address space configuration • 80  

V  
View and Output Definition dialog • 42  
View Info Area • 14  
view options  
  additional graph view options • 27  
  additional table view options • 15  

W  
Web Client • 7  
Windows Client  
  closing • 74  
  connect and login to z/OS host • 70  
  disconnecting from a z/OS host • 74  
  Menu Bar • 66  
  start • 64  
  Toolbar • 66  

Z  
z/OS host  
  configuration • 78, 80  
  connection status • 68  
  defining • 68  
  disconnect from • 74  
  logging in to • 70  
zooming to another object